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Because of the variety of uses for the products described in this
publication, those responsible for the application and use of this
control equipment must satisfy themselves that all necessary steps
have been taken to assure that each application and use meets all
performance and safety requirements, including any applicable laws,
regulations, codes and standards.

The illustrations, charts, sample programs and layout examples
shown in this guide are intended solely for purposes of example.
Since there are many variables and requirements associated with any
particular installation, Allen-Bradley does not assume responsibility
or liability (to include intellectual property liability) for actual use
based upon the examples shown in this publication.

Allen-Bradley publication SGI-1.1, Safety Guidelines for the
Application, Installation, and Maintenance of Solid-State Control
(available from your local Allen-Bradley office), describes some
important differences between solid-state equipment and
electromechanical devices that should be taken into consideration
when applying products such as those described in this publication.

Reproduction of the contents of this copyrighted publication, in
whole or in part, without written permission of Allen-Bradley
Company, Inc., is prohibited.

Throughout this manual we use notes to make you aware of safety
considerations:

!
ATTENTION: Identifies information about practices
or circumstances that can lead to personal injury or
death, property damage or economic loss.

Attention statements help you to:

• identify a hazard

• avoid the hazard

• recognize the consequences

Important: Identifies information that is critical for successful
application and understanding of the product.

PanelBuilder, PanelView 550, PanelView 600, PanelView 900, PanelView 1400, SLC, SLC 500, SLC 5/01, SLC 5/02, SLC
5/03, SLC 5/04, Data Highway Plus are trademarks of Allen-Bradley Company, Inc.
PLC and PLC-5 are registered trademarks of Allen-Bradley Company, Inc.
RSLinx and INTERCHANGE are trademarks of Rockwell Software Inc.
Microsoft, Windows, and MS-DOS are registered trademarks, and Windows NT is a trademark of Microsoft Corporation.

Important User
Information
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Welcome to the PanelBuilder  Software.  To help you get started,
this guide provides some basics on using the software and a sample
application.  It takes you through all the steps that are required to
create, download and run the sample application in a Remote I/O,
DH-485 or DH+ PanelView  terminal.

This guide is intended as an introduction.  For more information on
software features and how to perform specific tasks refer to the
PanelBuilder Software User Manual.

PanelBuilder runs in the Microsoft�  Windows� environment.  You
should be familiar with basic window operations; such as how to use
the mouse, choose commands and work with windows and dialog
boxes.

• Preface
An overview of this guide and what you need to create, download
and run the sample application.

• Chapter 1 – PanelBuilder Basics
Takes a quick look at the PanelBuilder Software.

• Chapter 2 – Initial System Setup
Describes the setup of system components and how to load the
required ladder logic program into a PLC or SLC controller.

• Chapter 3 – Overview of Sample Application
Provides a description of the sample application and its function.

• Chapter 4 – Creating the Sample Application
Provides step-by-step instructions for creating the sample
application.

• Chapter 5 – PanelView Terminal Setup
Shows how to set runtime communication parameters and
power-up options for the PanelView terminal and controller.

• Chapter 6 – Entering the Application Tags
Shows how to use the Tag Editor to enter tags for the application.

• Chapter 7 – Validating and Downloading the Application
Shows how to download the sample application to a PanelView
terminal.

• Chapter 8 – Running the Application
Shows how to run the application in the PanelView terminal.

Contents of this Guide
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The following conventions are used in this guide.

• PanelBuilder refers to the PanelBuilder Configuration Software.

• Terminal refers to a PanelView Operator Terminal.

• Windows refers to Microsoft Windows versions 3.1 (or higher),
or Windows 95.

• Keys on the keyboard appear in small capital letters.  For
example, the Ctrl key appears as CTRL in the text, the Alt key as
ALT, and so on.

• When keys are to be pressed in combination, you’ll see them
connected by a +.  For example, ALT+F4 means hold down the ALT

key while you press F4.

• Bold text precedes all procedures.

To open an application file:

• A solid right cursor in the left margin indicates a tip or hint.

Anchor point is the handle opposite the handle you choose.  The
anchor point doesn’t move when sizing objects.

The following table lists other publications related to the
PanelBuilder Software and the PanelView Operator Terminals.

Publication Title Publication No.

PanelBuilder Software User Manual 2711-6.0

PanelView Terminal User Manual 2711-6.1

PanelView File Transfer Utility 2711-805

For information on your PLC or SLC controller, the Advanced
Programming Software, or the 6200 Series Programming Software,
refer to the appropriate manuals.

For information on window operations, refer to your Windows user
guide.

Conventions

�

Related Publications
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This section lists the items needed to create, download and run the
sample application in a PanelView terminal using either:

• Remote I/O communications

• DH-485 communications

• DH+ communications

Personal Computer

The minimum system requirements for installing and running
PanelBuilder Software on a personal computer are:

• Personal computer with a 386 or higher processor

• MS-DOS� operating system version 5.0 or later

• Windows� 3.1 or later (Windows for Workgroups 3.11 or later),
Windows 95, or Windows NT 4.0.

• 500K free conventional memory

• at least 40 MB available hard disk space

• VGA or other high-resolution display supported by Windows

• Mouse or other Windows pointing device

PanelBuilder Software

The PanelBuilder Software (Catalog No. 2711-ND3) is required to
create applications on a computer for PanelView terminals.

Install the PanelBuilder Software as described in Chapter 2 of the
PanelBuilder Software manual.

What You Need

�
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PanelView Operator Terminal

The sample application operates with all of PanelView terminals.
The differences are in the:

• display type (monochrome or color)

• operator input (touch screen or keypad)

• communication ports (Remote I/O, DH-485, RS-232, DH+)

Download Cables

Remote I/O, RS-232 or DH+ Versions of PanelView Terminals

Theses PanelView terminals require one of the following cables to
download applications using an RS-232 connection:

• Catalog No. 2711-NC13

• Catalog No. 2711-NC14

• Catalog No. 2706-NC13

The only difference between the cables is the cable length.

DH-485 Versions of PanelView Terminals

The DH-485 versions of the PanelView terminals require the
following items to download applications:

• Personal Computer Interface Converter (Catalog No. 1747-PIC)

• Communications Cable (Catalog No. 1747-C10, -C11, -C20)

The Personal Computer Interface Converter receives power from an
SLC controller.  Downloading an application to the terminal without
an SLC connected requires a power supply (Catalog No. 1747-NP1)
or a powered Link Coupler (Catalog No. 1747-AIC).

Communication Cable

A communication cable is required to connect the PanelView
terminal to a PLC or SLC controller.

Remote I/O Versions of PanelView Terminals

The Remote I/O versions of the PanelView terminals connect to a
PLC controller using Remote I/O cable (Catalog No. 1770-CD),
which is equivalent to the Belden 9463 cable.
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DH-485 Versions of PanelView Terminals

The DH-485 versions of the PanelView terminals require one of the
following:

• Catalog No. 1747-C10

• Catalog No. 1747-C11

• Catalog No. 1747-C20

The only difference between the cables is the cable length.

RS-232 Versions of PanelView Terminals

The RS-232 versions of the PanelView terminals use the same cable
for downloading and communications.

• Catalog No. 2711-NC13

• Catalog No. 2711-NC14

• Catalog No. 2706-NC13

DH+ Versions of PanelView Terminals

The DH+ versions of the PanelView terminals connect to a DH+ link
using a Belden 9463 cable (Catalog No. 1770-CD).

PLC or SLC Controller

Remote I/O Versions of PanelView Terminals

The Remote I/O versions of the PanelView terminal operate with a
PLC 5 or SLC controller (with a 1747-SN Scanner).  The sample
application uses a PLC 5/25 controller.

DH-485 Versions of PanelView Terminals

The DH-485 versions of the PanelView terminal operate with both
fixed and modular style SLC 500 controllers.

RS-232 Versions of PanelView Terminals

The RS-232 versions of the PanelView terminal require an SLC 5/03
or 5/04 controller.

DH+ Version of PanelView Terminals

The DH+ versions of the PanelView terminal operate with either a
PLC 5 or SLC controller.  The sample application uses a PLC 5/25
controller.
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Application and Ladder Logic Program

The PanelBuilder installation disks contain:

• Getting Started application (.PBA files) for each of the
PanelView terminals.

• Required ladder logic to run the application, including:

– SLC ladder logic files for DH-485/DH+ application
– PLC ladder logic files for Remote I/O application
– PLC ladder logic files for DH+ application

The files are stored on your computer as follows:

DH-485 or DH+ Application C:\AB\PBWIN\GS\5BV2485.PBA
5KV2485.PBA
6BV2485.PBA   

  6KV2485.PBA
9CKV2485.PBA
9CTV2485.PBA
9MKV2485.PBA
9MTV2485.PBA 
10KC_485.PBA
10KG_485.PBA
10TC_485.PBA
10TG_485.PBA 
14MKV2485.PBA
14MTV2485.PBA

SLC Ladder Logic Files C:\AB\SLC500\GS\GETSTRTD.AC$
GETSTRTD.ACH
GETSTRTD.B0$
GETSTRTD.B1$
GETSTRTD.B2$
GETSTRTD.IX$
GETSTRTD.LX$
GETSTRTD.NAM
GETSTRTD.OP$
GETSTRTD.PC$
GETSTRTD.XD$
GETSTRTD.XO$

Remote I/O Application C:\AB\PBWIN\GS\5BV2RIO.PBA
5KV2RIO.PBA
6BV2RIO.PBA   

  6KV2RIO.PBA
9CKV2RIO.PBA
9CTV2RIO.PBA
10KC_RIO.PBA
10KG_RIO.PBA
10TC_RIO.PBA
10TG_485.PBA 
9MKV2RIO.PBA
9MTV2RIO.PBA  
14MKV2RIO.PBA
14MTV2RIO.PBA      
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PLC (RIO) Ladder Logic Files C:\AB\PLC5\GS\GSRIO.AC$
GSRIO.AF5
GSRIO.B0$
GSRIO.B1$
GSRIO.D1$
GSRIO.IX$
GSRIO.LX$
GSRIO.OP$
GSRIO.P1$
GSRIO.PC$
GSRIO.TTL

PLC (DH+) Ladder Logic Files C:\AB\PLC5\GS\GSDHP.AC$
GSDHP.AF5
GSDHP.B0$
GSDHP.B1$
GSDHP.D1$
GSDHP.IX$
GSDHP.LX$
GSDHP.OP$
GSDHP.P1$
GSDHP.PC$
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This chapter covers basics on using PanelBuilder Software. 

Section Page

Windows Environment  1–1

PanelBuilder Windows  1–2

Accessing Objects  1–4

Placing Objects  1–5

Selecting Objects  1–7

Sizing Objects  1–8

Moving Objects  1–8

Getting Help  1–9

PanelBuilder runs in the Microsoft Windows environment. You
should be familiar with window operations.  That is, you should
know how to use the mouse, choose menu commands, and work with
windows and dialogs.

If you use a mouse, here are the basic terms used:

Term Means

Click Position the mouse pointer on the object, area or field, then
press and release the left mouse button once.

Double-click Position the mouse pointer on the object, area, or field and
then click the left mouse button twice quickly.

Select item or command Click to highlight the item to be affected by the next
command, or click on a dialog box option.

Choose item or command Click on a tool, menu command or an item in a dialog box or
Help window.

Drag Click where to start a selection and hold down the left
mouse button. Move pointer to end of selection and release
the mouse button.  Use drag to highlight a text string.

If you prefer to use the keyboard:

Term Means

Choose menu command Press the ALT key and type the underlined letter in the
menu name .  Then type the letter underlined in the
command name.

Select item or command Use the arrow keys (or in a dialog, both the TAB and arrow
keys) to move to the item.

Choose item or command Highlight an item, then press the ENTER key.

Chapter Objectives

Windows Environment
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Each time you start PanelBuilder, the PanelBuilder window opens.
This is where you create an application.  Window elements are
described below.

Control-Menu

Menu Bar
Tool Bar

Format Bar *

Border

Mouse Pointer

Status Bar

Title Bar Maximize Button
Minimize Button

Command

 ⇐⇒ Resizes 
Window

Close Button

Feature How to use it

Menu Bar Click a name on the menu bar to open a menu and display its
commands.
Or press ALT-X, where X is the underlined letter in the menu name.

Command Click a command to choose it or carry out its action.
Or type the underlined letter in the command name.

Title Bar Drag to move a window.

Tool Bar Click a tool to carry out a frequently used command.  The tool bar
toggles on and off from the View menu.

*Format Bar Click a tool to format an object or text.  The format bar doesn’t
appear until you open an application.

Status Bar Shows what PanelBuilder is doing at the moment.  The status bar
toggles on and off from the View menu.

Control-Menu Click to open the Control menu.  Double-click to close a window.

Minimize button Click to reduce window to an icon.

Maximize button Click to enlarge a window.

Close button Closes the window.

Border Drag to change the size of a window.

Mouse pointer Use to select an item or object.

PanelBuilder Windows
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Application File Window

When you open an application, the application file window opens
listing all screens in the application by number and name.

Maximize Button
Minimize Button
Title Bar

Border

Application File Window

Control-menu

 ⇐⇒ Resizes 
Window

Close Button

Application Screen Window

Each application screen looks like the PanelView terminal (touch,
keypad, or keypad & touch) for which you are creating the
application.  Objects are placed inside the display area.  On keypad
terminals, you can also place objects on function keys. Screens are
moved and sized like any other window. Multiple screens can be
open at one time.

Application Screen

Title Bar
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Objects are accessed from the Objects menu or the Toolbox.

Toolbox toggles on and 
off from the View menu.

Draw Pointer

After selecting an object and moving the mouse pointer into the
display area, the pointer changes to a crosshair (+).  The crosshair
indicates where an object appears when you place it.

If moved to an illegal area of the screen, the crosshair looks like this
.

Accessing Objects
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On touch screen terminals, objects are placed in the display area.  On
keypad terminals, objects are placed in the display area and assigned
function keys.  On terminals that support both keypad and touch
input, you place objects in the display area or on function keys.

To create an object in the display area:

1. Choose an object from the Objects menu.

Or click the appropriate tool in the toolbox.

2. Position the pointer (+) where you want to place the object.

3. Click the left mouse button to place the default size.

Or hold down the left mouse button and drag the pointer to size
the object.  Release the mouse when the object is the right size.
The object is automatically selected.

Object

Drag Pointer
to Size Object

4. To place another object of the same type, move the pointer to a
new location and repeat step 3.

5. Click the right mouse button to exit the object mode.

Or click the selection tool in the toolbox.

Or press the ESC key.

For each object placed on the screen, the status bar shows:

• Object ID number (assigned by PanelBuilder)

• X and Y coordinates of upper left corner of object (in pixels).
Coordinates are referenced from upper left corner of display
(x=0, y=0).

• Width and height of object (in pixels)

• Object type (right element of status bar)

Placing Objects
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To create an object on a function key:

1. Choose an object from the Objects menu.

Or click the appropriate tool in the toolbox.

2. Position the pointer (+) over a function key and click the left 
mouse button.

If the function key is already assigned to an object, the pointer
changes to .  Reposition pointer over another key.

Pointer over Function Key

A graphic appears on the function key showing the object type.
An asterisk also appears next to the key number.

*F1

Graphic
Asterisk

3. Click the right mouse button to exit the object mode.

Or click the selection tool in the toolbox.
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Before you can move, size or format an object you must first select
the object.  A selected object has handles.  

To select an object:

Position the mouse pointer anywhere on the object and press the left
mouse button.  Handles appear on the object.

A line has one handle at each end.  Rectangles and squares have
handles around their edges.  Other objects (ellipses and circles) have
handles around an invisible bounding box.

To deselect an object:

• Position pointer outside the object and press the left mouse
button.

• Or select another object.

To select multiple objects:

1. Position pointer above and to the left of the objects you want to
group.

2. Press the left mouse button and drag a selection rectangle around 
the objects.

Selection Rectangle

3. Release the mouse button.

The other way to select multiple objects is to hold down the SHIFT

key and click on each object.  To add or remove an object from the
selection, hold down the SHIFT key and click on the object.

To select all objects:

Choose Select All from the Edit menu.

Handles appear on all objects to show that they’re all selected.

Selecting Objects

�
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To size an object:

1. Select the object by clicking anywhere on the object.  
Handles appear on the object.

Handle

2. Position the pointer over one of the handles.

The pointer changes to show the direction you can size the object.

Size Horizontally

Size Vertically

Size Diagonally

3. Press the left mouse button and drag the handle.

The object stretches from the anchor point to the position of the
pointer, expanding and contracting as you move the mouse.

The anchor point is the handle opposite the handle you choose.  It
does not move when objects are sized.

4. Release the mouse button when the object is the right size.

Objects with inner graphics can’t be sized smaller than the graphic.  
You might have to move or delete the inner graphic to size the object
appropriately.

To move an object:

1. Move the pointer anywhere inside the object.

2. Hold down the left mouse button and drag the object to its new
location.  The pointer changes to show that you are moving the
object. An outline appears as you drag the object.

Old Location New Location New Location

3. Release the mouse button.

Sizing Objects

�

Moving Objects
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Help for PanelBuilder is available by choosing a command from the
Help menu or pressing the F1 key.  The following help window opens
when you choose Index from the Help menu. 

Help feature How to use it

Contents button Choose to see a list of topics.

Search button Choose to search for topics by keywords.

Back button Choose to view the previous topic.  Continue to choose the button
to step back through all the topics.

History button Choose to display a list of topics you have viewed.  In the list,
double-click a topic name to view it again.

>> Choose to display the next topic in a series of topics.

<< Choose to display the previous topic in a series of topics.

Getting Help
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This chapter contains these sections.

Sections Page

Setting up System Components  2–1

Loading the SLC Ladder Logic Program  2–5

Loading the PLC Ladder Logic Program  2–5

This section shows how to set up the system components that are
required to install, download and run the sample application. 

System Components for PanelView with DH-485 Ports

• DH-485 PanelView Terminal

• Personal Computer with installed:

– PanelBuilder Software
– Advanced Programming Software (APS)

• SLC 500 Controller

• 2 Communication Cables (Catalog No. 1747-C10, -C11 or -C20)

• Personal Computer Interface Converter (Catalog No. 1747-PIC)

Make the connections shown below. No other connections are
required.

Node 0
Personal Computer

Personal Computer
Interface Converter

Catalog No. 1747-PIC

Node 1
SLC Controller

PanelBuilder

Node 2
PanelView 900 DH-485 Terminal Shown

Cable
Catalog No. 1747-C10, -C11, -C20

Serial Port
COM1 or COM2

DH-485 Connector DH-485 Connector

Chapter Objectives

Setting up
System Components
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System Components for PanelView with RS-232 (DH-485) Port

• RS-232 PanelView Terminal

• Personal Computer with installed:

– PanelBuilder Software
– Advanced Programming Software (APS)

• SLC 5/03 or 5/04 Controller

• One Communication Cable (Catalog No. 2711-NC13,-NC14 
or 2706-NC13)

Node 0
Personal Computer

PanelBuilder

Node 2
PanelView 900 RS-232 Terminal Shown

Node 1
SLC 5/03 or 5/04 Controller

Cable 
Catalog No. 2711-NC13,
2711-NC14, 2706-NC13

Note:  The same cable is used for transferring applications to the terminal and
for connecting the terminal to the SLC 5/03 or 5/04 Controller.  After downloading
the application, disconnect the cable from the computer and connect to Channel
0 Port of SLC 5/03 or 5/04.

To Channel 0

Serial Port
COM1 or COM2
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System Components for PanelView with Remote I/O Port

• Remote I/O PanelView Terminal

• Personal Computer with installed:

– PanelBuilder Software
– 6200 Series Programming Software

• PLC-5 Controller

• One RIO Communication Cable (Catalog No. 1770-CD),
equivalent to a Belden 9463 cable.  Along with two RIO
connectors, one RIO connector is provided with the terminal.

• One RS-232 Communication Cable (Catalog No.
2711-NC13,-NC14 or 2706-NC13) 

Node 0
Personal Computer

PanelBuilder

Node 1
PLC-5 Controller

Cable 
Catalog No. 1770-CD

(Belden 9463)

Cable 
Catalog No. 2711-NC13,
2711-NC14, 2706-NC13

Node 2
PanelView 900 Remote I/O Terminal Shown

Remote I/O Port
3-Pin Terminal Block ConnectorRS-232 Port

Serial Port
COM1 or COM2

PLC RIO Port
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System Components for PanelView with DH+ Port

• DH+ PanelView Terminal

• Personal Computer with installed:

– PanelBuilder Software
– 6200 Series Programming Software

• PLC-5 Controller

• One Communication Cable (Catalog No. 1770-CD), equivalent to
a Belden 9463 cable.

• One RS-232 Communication Cable (Catalog No.
2711-NC13,-NC14 or 2706-NC13) 

Node 0
Personal Computer

PanelBuilder

Node 1
PLC-5 Controller

Cable 
Catalog No. 2711-NC13,
2711-NC14, 2706-NC13

Node 2
PanelView 900 DH+ Terminal Shown

DH+ Port
3-Pin Terminal Block Connector

RS-232 Port

Serial Port
COM1 or COM2

PLC DH+ Port

82� or 150�
resistor

Blue
Shield
Clear

2
SH

1

1

2
SH

Clear
Shield

Blue

2 1
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For DH-485 or DH+ applications that communicate with an SLC
controller, the required ladder logic program and data files are
supplied on the PanelBuilder installation disks.

The following files are installed in the C:\AB\SLC500\GS directory
during PanelBuilder installation.

SLC Ladder Logic Files

GETSTRTD.AC$
GETSTRTD.ACH
GETSTRTD.B0$
GETSTRTD.B1$
GETSTRTD.B2$
GETSTRTD.IX$

GETSTRTD.LX$
GETSTRTD.NAM
GETSTRTD.OP$
GETSTRTD.PC$
GETSTRTD.XD$
GETSTRTD.XO$

Run the APS software installed on your computer and load the
ladder logic program into the SLC controller.  Appendix A contains
the documented ladder logic program.

For details on how to use the Advanced Programming Software refer
to the appropriate manuals.

For Remote I/O and DH+ applications that communicate with a
PLC5 controller, the required ladder logic program and data files are
supplied on the PanelBuilder installation disks.

The following files are installed in the C:\AB\PLC5\GS directory
during PanelBuilder installation.

  PLC (RIO) Ladder Logic Files  PLC (DH+) Ladder Logic Files

GSRIO.AC$
GSRIO.AF5
GSRIO.B0$
GSRIO.B1$
GSRIO.D1$
GSRIO.IX$

GSRIO.LX$
GSRIO.OP$
GSRIO.P1$
GSRIO.PC$
GSRIO.TTL

GSDHP.AF5
GSDHP.AC$
GSDHP.B0$
GSDHP.B1$
GSDHP.D1$
GSDHP.IX$

GSDHP.LX$
GSDHP.OP$
GSDHP.P1$
GSDHP.PC$

Load the ladder logic program into the PLC controller.  Appendix B
contains the ladder logic for the Remote I/O application. Appendix C
contains the ladder logic for the DH+ application.

For details on how to load the ladder logic program into the PLC
controller, to the appropriate user manuals.

Loading the SLC
Ladder Logic Program

Loading the PLC
Ladder Logic Program
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Overview of Sample Application

This chapter contains these sections.

Sections Page

Purpose of Application  3–1

Application Screens  3–2

Motor Status Screen  3–3

Motor Speed Screen  3–4

Alarm Banner  3–5

Application Tags  3–6

DH-485 or DH+ Application Tags  3–7

Remote I/O Application Tags  3–8

The Getting Started application contains objects to control and
monitor the status of a motor.  The PanelView terminal reads/writes
data to either:

• an SLC 500 controller on a DH-485 network

• an SLC 500 controller or PLC 5 controller on a DH+ network

• a PLC 5 controller on a Remote I/O network

Chapter 4 gives procedures for creating the application on a
PanelView 900 monochrome terminal with function keys.

• If creating the application for any of the PanelView touch screen
terminal, touch cell input is automatically enabled.

• If creating the application for a PanelView color terminal, the
procedures reference colors.

For PanelView grayscale terminals, the color palette shows 4
shades of gray.  Select the appropriate shades.

• If creating the application for other PanelView terminals, use
appropriate text sizes.

You can open any of the .PBA files stored in AB\PBWIN\GS to view
the getting started application on your computer.

Chapter Objectives

Purpose of Application
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The application contains 3 screens: 

• Motor Status

• Motor Speed

• Alarm Banner (V2.0 or later software only)

The Motor Status and Motor Speed screens each contain a screen
button allowing you to navigate between the two screens.

The Alarm Banner is a global display that pops up over the Motor
Status or Motor Speed screen when an alarm is triggered.  Alarms
are supported in PanelBuilder V2.0 (or later) Software.

For touch screen terminals, the application includes a CONFIG
SCREEN button allowing the operator to display the terminal’s
Configuration Mode menu when the application is running.

Application Screens
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Motor Status Screen

The Motor Status screen is the first screen that appears when you
power on the PanelView terminal. It allows you to:

• start and stop motor

• set motor control to auto or manual mode

• monitor status (start/stop) and mode (auto/manual) of motor

• go to the Motor Speed screen

Touch Screen TerminalKeypad Terminal

The following table lists objects on the Motor Status screen and each
object’s function.  Object headings are created as background text.

Object Object Type Function

Standard Control List
with Background Text

Sets the motor to auto or manual mode by
moving the cursor up or down and pressing
the Enter key.

The touch screen terminal requires list keys
to move the cursor through the control list
and select an option.

Momentary Push Button
(Normally Open)

Starts the motor when you press the F1 key
or touch the screen object.

Momentary Push Button
(Normally Open)

Stops the motor when you press the F2 key
or touch the screen object.

Motor

F8
Speed

Goto Screen Button Displays the Motor Speed screen when you
press the F8 key (F5 on PV550 terminals) or
touch the screen object.

2 Multistate Indicators
with Background Text

MODE indicator shows whether the motor is
in AUTO or MANUAL mode.

STATUS indicator shows whether the motor
is on (START) or off (STOP).
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Motor Speed Screen

The Motor Speed screen allows you to:

• monitor motor speed

• increase or decrease motor speed

• enter a new motor speed

• go to the Motor Status screen

Touch Screen TerminalKeypad Terminal

The table below lists objects on the Motor Speed screen and each
object’s function.  Object headings are created as background text.

Object Object Type Function

Numeric Cursor Point
with Background Text

Opens the scratchpad for entering a new
motor speed (from 0 to 1000 rpm).

Numeric Data Display Displays the current speed (0 to 1000
rpm) of the motor.

Bar Graph and Scale
with Background Text

Displays the current motor speed (0 to
1000 rpm) in a graphic form.

The bar graph scale and tick-mark labels
are created as separate objects.

Momentary Push Button
(Normally Open)

Increases the speed of the motor when
you press the F1 key or touch the screen
object.

Momentary Push Button
(Normally Open)

Decreases the speed of the motor when
you press the F2 key or touch the screen
object.

Motor
Status

F8

Goto Screen Button Displays the Motor Status screen when
you press the F8 key (F5 on PV550
terminals) or touch the screen object.

Application Screens



 3–5Overview of Sample Application

Publication 2711-6.2

Alarm Banner

The Alarm Banner is a global display that pops up over the Motor
Status or Motor Speed screen when an alarm is triggered.  It allows
you to:

• read a message associated with the triggered alarm

• clear the Alarm Banner from the screen

• acknowledge an alarm and clear the banner from the screen.

Keypad Terminal

The table below lists objects on the Motor Speed screen and each
object’s function.  The Message Display is a fixed object that cannot
be deleted.

Object Object Type Function

Message Display Triggers a message to display when the
motor speed is too high or too low.

Clear Alarm Button Clears the Alarm Banner from the
screen when you press the F4 key or
touch the screen object.

Ack Alarm Button Acknowledges the alarm displayed in
the Alarm Banner and clears the banner
from the screen when you press the F7
key or touch the screen object.



 3–6 Overview of Sample Application

Publication 2711-6.2

The sample application has a collection of read/write tags that define
how objects interact with SLC 500 or PLC controller addresses.  The
following table defines the attributes of each tag. 

Tag Attributes Description

Tag Name Unique name identifying tag address

Data Type Bit, 4BCD, Unsigned/Signed Integer, Bit Array,
Character Array, Float

Array Size Array size (length) of bit array

Description General description of tag

Node Name Name of controller associated with tag

Tag Address Specifies data table word or bit

Initial Value Value stored at tag address on powerup

Update Frequency Rate at which tag address value is updated

Scaling1 Scale and offset scale values

Data Entry Limits1 High and low limits of data stored at tag address
1  Fields display only if data type is 4BCD, Signed/Unsigned Integer, or IEEE Float.

Tags used by the DH-485 or DH+ application are stored in a tag
database that is referenced by the project name GS.  The GS project
has 9 tags.

Tags used by the Remote I/O application are stored in a database
referenced by the project GSRIO.  The GSRIO project has 12 tags.
Tags are created using the Tag Editor.

Objects that don’t read or write to a controller address such as screen
selector buttons and background text do not require a tag.

Application Tags
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DH-485 or DH+ Application Tags

This section defines the GS project tags that are used by the DH-485
or DH+ application.

• For a DH-485 application, these tags read or write data to bit or
integer files associated with an SLC 500 controller.

• For a DH+ application, these tags read or write data to bit or
integer files associated with an SLC 500 or PLC 5/25 controller.

GS Project Tags for DH-485 or DH+ Application

This object Uses this tag To

Motor_Start
Motor_Start_Ind

Start the motor by setting bit B3:0/0 ON (1).

Control state change by monitoring bit B3:0/4.

Motor_Stop
Motor_Stop_Ind

Stop the motor by setting bit B3:0/1 OFF (0).
Control state change by monitoring bit B3:0/5.

Motor_Stop_Ind Display the current status (START or STOP) of
the motor by reading bit B3:0/5.

Motor_AutoManual Set the motor to AUTO or MANUAL mode by
writing an unsigned integer value to N7:0.

Motor_AutoManual Display the current mode (AUTO or MANUAL)
of the motor by reading the data at N7:0.

Motor_Speed Enter a new motor speed (0 to 1000 rpm) by
writing an unsigned integer value to N7:1.

Motor_Speed_Ind Display the current motor speed in a graphic
form by reading the data at N7:2.

Motor_Speed_Dec Decrease the motor speed by setting bit B3:0/3
ON (1) and OFF (0).

Motor_Speed_Inc Increase the motor speed by setting bit B3:0/2
ON (1) and OFF (0).

Messages Trigger a message to appear in the Alarm
Banner by reading the trigger value at N7:3.



 3–8 Overview of Sample Application

Publication 2711-6.2

Remote I/O Application Tags

This section defines the GSRIO project tags that are used by the
Remote I/O application.  These tags read or write data to bit, integer
and input/output files associated with a PLC 5/25 controller on a
Remote I/O link. 

GSRIO Project Tags for Remote I/O Application

This object Uses this tag To

Motor_Start
Motor_Start_Ind

Start the motor by setting bit I:010/10 ON (1).
Control state change by monitoring bit O:010/10.

Motor_Stop
Motor_Stop_Ind

Stop the motor by setting bit I:010/11 ON (1).
Control state change by monitoring bit O:010/11.

Motor_Stop_Ind Display the current status (START or STOP) of the
motor by reading bit O:010/11.

Motor_AutoManual Set the motor to AUTO or MANUAL mode by
writing an unsigned integer value to N7:10.

Motor_AutoMan_Ind Display the current mode (AUTO or MANUAL) of
the motor by reading the data at N7:3.

Motor_Speed Enter a new motor speed (0 to 1000 rpm) by writing
an unsigned integer value to N7:13.

Motor_Spd_Notify When a new motor speed is entered, the bit at
N7:11/4 is set ON (1).  The scratch pad remains
open until new motor speed is written to N7:13.
The terminal clears bit N7:11/4 when the 
Motor_Spd_Handshk tag is set (ON) 1.

Motor_Spd_Handshk Sets bit N7:2/2 ON (1) when the new motor speed
is written to the Motor_Speed tag at N7:13.
The ladder logic program clears bit N7:2/2.

Motor_Speed_Ind Display the current motor speed in numeric form (0
to 1000 rpm) by reading the data at N7:1.

Motor_Speed_Ind Display the current motor speed in a graphic form
by reading the data at N7:1.

Motor_Speed_Dec Decrease the motor speed by setting bit N7:11/0 ON
(1) and OFF (0) in Manual Mode.

Motor_Speed_Inc Increase the motor speed by setting bit N7:11/1 ON
(1) and OFF (0) in Manual Mode.

Messages Trigger a message to appear in the Alarm Banner
by reading the trigger value at N7:4.
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This chapter shows how to create the sample application and
contains the following sections.

You can create the entire application or part of the application.  The
complete DH-485 (or DH+) and Remote I/O applications are
provided on the installation disk and are stored in
C:\AB\PBWIN\GS\

Section Page

Starting PanelBuilder  4–2

Opening a New Application File  4–3

Creating the Motor Status Screen  4–4

Opening a New Screen  4–4

Setting Grid Attributes  4–5

Creating the Start Motor Push Button  4–6

Creating the Stop Motor Push Button  4–8

Creating the Motor Speed Screen Button  4–11

Creating a Goto Config Screen Button  4–12

Creating the Select Mode Control List  4–13

Creating Control List Keys  4–16

Creating the Mode Indicator  4–17

Creating the Status Indicator  4–21

Closing the Motor Status Screen  4–24

Creating the Motor Speed Screen  4–25

Opening the Toolbox and Color Palette  4–25

Opening a New Screen  4–26

Creating the Increase Speed Push Button  4–26

Creating the Decrease Speed Push Button  4–28

Creating the Motor Status Screen Button  4–29

Creating the Speed Bar Graph and Scale  4–31

Creating the Speed Numeric Entry Object  4–34

Creating the RPM Data Display  4–37

Closing the Toolbox and Color Palette  4–39

Closing the Motor Speed Screen  4–39

Linking the Motor Status and Motor Speed Screen  4–39

Creating Alarms  4–40

Saving the Application  4–43

Chapter Objectives
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To start PanelBuilder 900:

• For computers running Windows 3.x:

– At the DOS prompt, type win and press ENTER.
– Double-click the PanelBuilder group icon in the Program

Manager.
– Double-click the PanelBuilder icon.

• For computers running Windows 95:

– Click once on the Start button. Place the cursor over
Programs.  You will see the Programs submenu.

– Place the cursor over PanelBuilder.  You will see the
PanelBuilder submenu.

– Click on the PanelBuilder icon.

The startup screen opens showing copyright and release
information.

xx.xx.xx
xxx xx xxxx

The PanelBuilder window opens.  This is your workspace for
creating application screens.

Maximize
button

Click the Maximize button to enlarge the window.

Starting PanelBuilder

�
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To open a new application file:

1. Choose New from the File menu or click  on the tool bar.

The New Application dialog opens.

2. In the Application Name box, type Getting Started.

3. In the Project Name box, type:

– GSRIO for a Remote I/O application
– GS for a DH-485 or DH+ application

The project will contain tags and device information.

4. In the Terminal Name box, type PV550, PV600, PV900 or
PV1400. This name identifies the terminal to the project.

5. Choose a specific PanelView terminal by selecting:

– PV550, PV600, PV900M (Monochrome), PV900C (Color),
PV1400 in the PV Type box

– Keypad or Touch
– Catalog Number and Firmware Version of terminal

The Ports area shows the communication port(s) and protocol(s)
of the selected terminal.

Type Getting Started

Type GSRIO or GS

Type PV550, PV600, PV900 or PV1400

Select PV550, PV600,
PV900M, PV900C, PV1400

Select Catalog No. of a Remote I/O, DH+ or DH-485 Terminal

Communication port and
protocol of selected terminal

Select Keypad or Touch

6. Click the OK button.

The application file window opens showing the name of the
application and the selected terminal type.  Because the file does
not contain any screens the Screens box is empty.

Application Name

Opening a New Application
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This section shows how to create the MOTOR STATUS screen
which is the first application screen.

Select Mode Control List

Procedures in this section show how to

• Open a new screen

• Set grid attributes

• Create a momentary push button to start the motor

• Create a momentary push button to stop the motor

• Create a screen button to display the Motor Speed screen

• Create a control list to select auto or manual mode

• Create control list keys for touch screen terminals only

• Create an indicator to show the auto/manual mode of the motor

• Create an indicator to show the start/stop status of the motor

• Close the Motor Status screen

Opening a New Screen

To create the MOTOR STATUS screen:

1. Choose New from the Screen menu or click  on the tool bar.

PanelBuilder assigns a name/number to each screen starting at 1.

2. Type Motor Status in the Name box.

Type Motor Status

Background appears only
on color terminals.

3. Click the OK button to open screen 1.

Creating the
Motor Status Screen
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A blank application screen opens.  The title bar shows the screen
name and number.

An * after the application file name in the title bar means the
application has been modified but not saved.

Title Bar

Screen Number amd Mame

Project Name Application File Name after Save

Click the Title Bar  to move
the screen in the workspace

Setting Grid Attributes

For easier alignment and positioning of screen objects we
recommend that you adjust the Grid Spacing. 

To set the grid attributes:

1. From the Align menu choose Grid Attributes.

The Grid Spacing dialog opens.

2. Click in the X Pixels box and replace 13 with 5.

3. Click in the Y Pixels box and replace 25 with 5.

These settings vary for each PanelView terminal type.

4. Click OK.

�

�
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Creating the Start Motor Push Button

To create the START
MOTOR

F1
 push button:

1. From the Objects �Push Buttons submenu choose Momentary.

2. Position pointer (+) in lower left area of the screen, click the left
mouse button and drag the pointer diagonally to size the button.

3. Click the right mouse button to exit push button mode.

To set the properties of the push button:

1. Double-click the push button to open its dialog.

2. Set the properties as shown below.

Click Single Button

Select F1

Type Motor_Start

Type Motor_Start_Ind

Creating the
Motor Status Screen
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To configure the states of the Start Motor push button:

1. Click the States tab on the Push Buttons dialog.

A spreadsheet opens.  Each row represents a push button state
(row 0 is state 0, row 1 is state 1).

Use the horizontal scroll bar to
display fields not in view.

State 0
State 1

2. Edit the fields for state 0 (row 0) as follows:

• Double-click in the Text field and:
– type START, then press Enter (/*R*/ indicates return)
– type MOTOR, then press Enter ( /*R*/ indicates return)
– type F1

• Click in the Text Size field and select 16x24 from the list.
Don’t change the text size for PV550 applications.

Select these colors for state 0.  Click in each field and select:

• Light Green for the Object Background
• Black for the Object Foreground
• Light Green for the Text Background
• Black for the Text Foreground

3. Edit the fields for state 1 (row 1) as follows:

• Double-click in the Text field, press Enter (/*R*/), then type
MOTOR STARTED

• Select Black for the Object Background
• Select White for the Object Foreground
• Select Black for the Text Background
• Select White for the Text Foreground
• Click in the Text Size field and select 16x24 from the list.

Don’t change the text size for PV550 applications.

State 0
START
MOTOR

F1

For Color

State 1

MOTOR
STARTED
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Select these colors for state 1 (row 1):

• White for the Object Background
• White for the Object Foreground
• White for the Text Background
• Green for the Text Foreground

4. Click the OK button to exit the Push Buttons dialog.

An asterisk (*) appears if the text exceeds the size of the object.

5. Resize the object, if necessary, to fit all the text.

Creating the Stop Motor Push Button

The Stop Motor push button is created using the Copy and Paste
functions.

To create the Stop Motor push button:

1. Select  START
MOTOR

F1
 (if not selected).

2. From the Edit menu choose Copy or click  on the tool bar.

3. From the Edit menu choose Paste or click  on the tool bar.

An outline of the copied button appears.

4. Move the outline to the right and click the left mouse button to
paste the button.

Creating the
Motor Status Screen

For Color
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To set the properties of the Stop Motor push button:

1. Double-click the pasted push button to open its dialog.

2. Set the properties as shown below.

Type Motor_Stop

Type Motor_Stop_Ind
Select F2
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To configure the states of the Stop Motor push button:

1. Click the States tab on the Push Buttons dialog.

2. Double-click in the Text field for state 0 (row 0) and replace
START/*R*/MOTOR/*R*/F1 with  STOP/*R*/MOTOR/*R*/F2.

Remember, /*R*/ indicates a carriage return.

Select these colors for state 0 (row 0):

• Light Red for the Object Background
• Black for the Object Foreground
• Light Red for the Text Background
• White for the Text Foreground

3. Double-click in the Text field for state 1 (row 1) and replace
/*R*/MOTOR STARTED with /*R*/MOTOR STOPPED.

Select these colors for state 1 (row 1):

• White for the Object Background
• White for the Object Foreground
• White for the Text Background
• Light Red for the Text Foreground

4. Click the OK button to close the Push Buttons dialog.

STOP
MOTOR

F2

State 0

Creating the
Motor Status Screen

For Color

State 1

MOTOR
STOPPED

For Color
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Creating the Motor Speed Screen Button

To create the Motor Speed screen button:

1. From the Objects �Screen Selectors submenu choose Goto.

2. Position pointer (+) in the lower right area of the screen, hold
down the left mouse button and drag pointer diagonally to size
the button.

3. Click the right mouse button to exit screen button mode.

4. For monochrome applications, choose Toggle Fore/Background

from the Format menu or click  on the format bar.

Select Light Blue from the Format �Background Color menu

To change the inner text of the screen button:

1. From the Format menu, choose Inner Text or click the Inner Text

 tool on the tool bar.

Don’t worry about this number.
It’s not important.

2. Replace GoTo with 
MOTOR
SPEED

F8

ENTER key pressed twice

3. From the Format �Text Size menu choose 16x24.

Or click  on the format bar and choose 16x24 from the menu.

Don’t change the text size for PV550 applications.

Select Light Blue from the Format �Background Color menu

4. Click  to exit inner text mode.

For Color

For Color
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Creating a Goto Config Screen Button

Skip this section if you have a PanelView 900 or 1400 Keypad
terminal.

PanelView 900/1400 Touch Screen terminals require a Goto Config
Screen button on the screen.  This button enables the operator to
display the terminal’s Configuration Mode Menu while running the
application.

CONFIG 
SCREEN
button

To create the CONFIG SCREEN button:

1. From the Objects �Screen Selectors submenu choose Goto Config
Screen.

2. Position pointer (+) to the left of the Motor Speed button, hold
down the left mouse button and drag pointer diagonally to size
the button.

3. Click the right mouse button to exit screen button mode.

4. From the Format menu choose Toggle Fore/Background or click

 on the format bar.

Select Red from the Format �Background Color menu.

5. From the Format menu choose Inner Text or click 

6. Replace Goto Config Screen with CONFIG SCREEN.

The /∗R∗/ characters are inserted when you press ENTER.

Don’t worry if this number is different.
ENTER key pressed twice

7. From the Format �Text Size menu choose 16x24.

Or click  on the format bar and choose 16x24 from the menu.

Don’t change the text size for PV550 applications.

Select Red from the Format �Background Color menu.

8. Click  to exit inner text mode.

Creating the
Motor Status Screen

�

For Color

For Color
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Creating the Select Mode Control List

To create the Select Mode control list:

Select Mode Control List

1. From the Objects �Control List Selectors menu choose Standard.

2. Position the pointer (+), hold down the left mouse button and
drag the pointer to size the object.

3. Click the right mouse button to exit control list selector mode.

• Select Blue from the Format �Foreground Color menu.

• Select Light Cyan from the Format �Background Color menu.

To set the properties of the Select Mode control list:

1. Double-click the control list object to open its dialog.

2. Set the properties as shown below.

Click Wrap Around check box

Type 
Motor_Automanual

For Color
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To edit the states of the Select Mode control list:

1. Click the States tab on the Control List Selector dialog.

Delete states (rows) 2 – 15

2. Delete states 2 – 15.  These states are not used.

• click on row number 2.
• hold down the left mouse button and drag the mouse until

rows 2 through 15 are selected.
• click the right mouse button and choose Delete State from the

popup menu.

3. Edit the fields for state 0 (row 0) as follows:

• In the Text field, replace ST 0 with AUTO.
• In the Text Size field, select 16x24 from the list box. Don’t

change the text size for PV550 applications.

Select Blue from the Text Foreground field.

4. In the Text field for state 1 (row 1) replace ST 1 with MANUAL.

Select Blue from the Text Foreground field.

5. Click OK to close the dialog.

The object should look like this.

An asterisk (*) appears if the text exceeds the size of the object.

6. Resize the object, if necessary, to fit all the text.

Creating the
Motor Status Screen

For Color

For Color
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To create the SELECT MODE heading for the control list:

From the Objects �Graphics submenu choose Text.

7. Position the pointer (+) above the list, hold down the left mouse
button and drag the pointer to size the text block.

8. In the Text box, type SELECT MODE.

Don’t worry if this number is different.

9. Click  on the format bar and choose 16x24. Don’t change the

text size for PV550 applications.

An asterisk (*) appears if the text exceeds the size of the object.

• Select Light Cyan from the Format �Foreground Color menu.

• Select Black from the Format �Background Color menu.

10. Click the right mouse button to exit text object mode.

11. Click  to exit inner text mode.

12. Resize the text block, if necessary, to fit all the text.

For Color
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Creating Control List Keys

Skip this section if you have a PanelView keypad terminal.

PanelView 900 Touch Screen terminals require you to place the
Move Up, Move Down, and Enter list keys on the screen.  These
keys enable the operator to move the cursor in the control list and
select an option. 

Move Up Key

Move Down Key

Enter Key

To create the Move Up list key:

1. From the Objects �List Keys submenu choose Move Up.

2. Position the pointer at the upper right corner of the Select Mode
control list and click the left mouse button.  Size and move the
key if necessary.

• Select Blue from the Format �Foreground Color menu.
• Select Light Cyan from the Format �Background Color menu.

• Click the Inner Graphic tool on the tool bar , select Light

Cyan for the Format �Background Color and Blue for the

Object � Foreground Color, then click  again.

To create list the Move Down list key:

1. From the Objects �List Keys submenu choose Move Down.

2. Position the pointer below the Move Up key and click the left
mouse button.  Size and move the key if necessary.

Apply same colors as the Move Up key.

To create the Enter list key:

1. From the Objects �List Keys submenu choose Enter.

2. Position the pointer below the Move Down key and click the left
mouse button.  Size and move the key if necessary.

Apply same colors as the Move Up key.

�����

� �	� ������ ����
���
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Creating the Mode Indicator

Select Mode Control List Multistate Indicators

Border

The Motor Status box contains 2 indicators:

• MODE indicator (displays Auto/Manual mode of motor)

• STATUS indicator (displays Start/Stop status of motor)

To create the border around the indicators:

1. From the Objects �Graphics submenu choose Rectangle.

2. Position the pointer (+) where you want to start drawing the upper
left corner of the shape.

3. Hold down the left mouse button and drag the pointer to size the
shape.  Release the mouse button when the shape is the right size.

4. Click the right mouse button to exit rectangle mode.

You will create the status
indicators inside the rectangle.

Select Yellow from the Format �Background Color submenu.For Color
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To create the MODE indicator:

Mode indicator

1. From the Objects �Indicators submenu choose Multistate.

2. Position the pointer (+) in the lower left area of the box, hold
down the left mouse button and drag the pointer to size the
indicator.

3. Click the right mouse button to exit multistate indicator mode.

4. Choose None from the Format �Line Type submenu.

Or click  on the Format bar and choose None.

To set the properties of the MODE indicator:

1. Double-click the indicator object to open its dialog.

2. Set the properties as shown below.

Click Value

Type Motor AutoMan_Ind (for Remote I/O)
or Motor_AutoManual (for DH-485)

Creating the 
Motor Status Screen
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To configure the states of the MODE indicator:

1. Click the States tab on the Multistate Indicator dialog.

2. Delete states 2 and 3.  These states are unused.

• click on row number 2.
• hold down the left mouse button and drag the mouse until

rows 2 and 3 are selected.
• click the right mouse button and choose Delete State from the

popup menu.

3. Edit the fields for state 0 (row 0) as follows:

• In the Text field, replace ST 0 with AUTO.
• In the Text Size field, select 16x24 from the list box. Don’t

change the text size for PV550 applications.

Select these colors for state 0 (row 0).

• Yellow for the Object Background
• Blue for the Object Foreground
• Yellow for the Text Background
• Cyan for the Text Foreground

4. Edit the fields for state 1 (row 1) as follows:

• In the Text field, replace ST 1 with MANUAL.
• In the Text Size field, select 16x24 from the list box. Don’t

change the text size for PV550 applications.

Select these colors for state 1 (row 1).

• Yellow for the Object Background
• Black for the Object Foreground
• Yellow for the Text Background
• Cyan for the Text Foreground

5. Click OK to exit the dialog.

An asterisk (*) appears if the text exceeds the size of the object.

6. Resize the object, if necessary, to fit all the text.

For Color

For Color
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To create the MODE heading for the MODE indicator:

Heading

1. From the Objects �Graphics submenu choose Text.

2. Position the pointer (+) above the indicator, hold down the left
mouse button and drag the pointer to size the text block.

3. In the Text box, type MODE.

Don’t worry if this number is different.

4. Click on the format bar to underline the text.

5. Click  on the format bar and choose 16x24. Don’t change the

text size for PV550 applications.

• Choose Black from the Format �Foreground Color menu.
• Choose Yellow from the Format�Background Color menu.

6. Click the right mouse button to exit text mode.

7. Click  to exit inner text mode.

8. Resize the text block, if necessary, to fit all the text.

Creating the
Motor Status Screen

For Color
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Creating the Status Indicator 

Status Indicator

To create the STATUS indicator:

1. Select the MODE indicator and its heading, Hold  down the SHIFT

key and click on the Mode indicator object and the heading.

Handles appear on both objects.

2. Click the Copy  tool.

3. Click the Paste  tool.

4. Move the outline to the right of the MODE indicator and click the
left mouse button to paste the objects.

5. Deselect the objects by clicking anywhere outside border.
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To set the properties of the STATUS indicator:

1. Double-click on the word AUTO of the pasted indicator to open
its dialog.

Pasted indicator

2. Set the properties as shown below.

Type Motor_Stop_Ind

Click Single Bit

To configure the states of the STATUS indicator:

1. Click the States tab of the Multistate Indicator dialog.

2. In the Text field for state 0, replace AUTO with START.

Select these colors for state 0 (row 0):

• Yellow for the Object Background
• Green for the Object Foreground
• Yellow for the Text Background
• Green for the Text Foreground

Creating the
Motor Status Screen

For Color
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3. In the Text field of State 1, replace MANUAL with STOP.

Select these colors for state 1 (row 1):

• Yellow for the Object Background
• Blue for the Object Foreground
• Yellow for the Text Background
• Light Red for the Text Foreground

4. Click OK to close the dialog.

An asterisk (*) appears if the text exceeds the size of the object.

5. Resize the object, if necessary, to fit all the text.

To create the STATUS heading for the indicator:

1. Select the pasted heading.

Pasted heading

2. Click the Inner Text  tool.

3. In the Text box, replace MODE with STATUS.

Don’t worry if this number is different.

4. Click  to exit inner text mode.

5. Resize the text block, if necessary, to fit all the text

For Color
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To create MOTOR STATUS above the indicator box:

1. From the Objects �Graphics submenu choose Text.

2. Position the pointer (+) above the indicator box, hold down the
left mouse button and drag the pointer to size the text block.

3. In the Text box, type MOTOR STATUS.

Don’t worry if this number is different.

4. Click  on the format bar and choose 16x24. Don’t change the

text size for PV550 applications.

• Choose Yellow from the Format �Foreground Color submenu.
• Choose Black from the Format�Background Color submenu.

5. Click the right mouse button to exit text object mode.

6. Click  to exit inner text mode.

7. Resize the text block if necessary.

Closing the Motor Status Screen

To close the MOTOR STATUS screen:

Choose Close from the Screen menu.

Or double-click the control-menu box on the screen.

Control_menu box

The Application File Window now shows 1 screen.

Creating the 
Motor Status Screen
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This section shows how to create the MOTOR SPEED screen.

Procedures in this section show how to:

• open the toolbox and color palette

• open a new screen

• create a momentary push button to increase the motor speed

• create a momentary push button to decrease the motor speed

• create a screen button to return to the Motor Status screen

• create a bar graph to show the current speed in graphic form

• create a numeric entry object for entering the motor speed

• create a numeric data display to show the current speed

• linking the Motor Speed screen to the Motor Status screen

• close the Motor Speed screen

Opening the Toolbox and Color Palette

When creating the MOTOR SPEED screen, objects are selected from
a tool box and some colors are selected from the color palette (for
color terminals).

To open the Toolbox and Color Palette:

Choose Toolbox and then Color Palette from the View menu.

Use the Top Row to select Foreground Colors

Use the Bottom Row to select  Background Colors

View Box updates as  Foreground
and Background colors are selected

Move Toolbox or Palette by clicking title
bar and dragging box to a new location.

Creating the
Motor Speed Screen
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Opening a New Screen

To create the MOTOR SPEED application screen:

1. Choose New from the Screen menu or click

2. Type MOTOR SPEED in the Name box of the dialog.

3. Click OK to close the dialog and open screen 2.

Creating the Increase Speed Push Button

To create the Increase Speed push button:

1. Click the Momentary Push Button tool  in the toolbox.

2. Position the pointer (+) at the lower left corner of the screen,
click the left mouse button and drag the pointer horizontally to
size the button.

3. Click the right mouse button to exit push button mode.

Or click the selection  tool on the toolbox.

To set the properties of the push button:

1. Double-click the push button to open its dialog.

2. Set the properties as shown below.

Click Single Bit

Type
Motor_Speed_Inc

Select F1

Creating the
Motor Speed Screen
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To configure the states of the Increase Speed push button:

1. Click the States tab on the Push Buttons dialog.

2. Edit the fields for state 0 (row 0) as follows:

• In the Text field, replace ST 0 with /*R*/ INC SPD/*R*/F1
• In the Text Size field, select 16x24 from the list box. Don’t

change the text size for PV550 applications.

Select these colors for state 0 (row 0).

• Cyan for the Object Background
• White for the Object Foreground
• Cyan for the Text Background
• White for the Text Foreground

3. In the Text field for State 1, replace ST 1 with /*R*/INC.

Select these colors for state 1 (row 1).

• White for the Object Background
• Cyan for the Object Foreground
• White for the Text Background
• Cyan for the Text Foreground

4. Click OK to exit the dialog.

An asterisk (*) appears if the text exceeds the size of the object.

5. Resize the object, if necessary, to fit all the text.

State 0

INC SPD
F1

For Color

State 1

INC For Color
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Creating the Decrease Speed Push Button

To create the Decrease Speed push button:

1. Select MENU
F5

INC SPD
F1

(if not selected).

2. Click the Copy  tool.

3. Click the Paste  tool.

4. Move outline of object to the right and click the left mouse button
to paste the object.

To set the properties of the Decrease Speed push button:

1. Double-click the pasted object to open its dialog.

2. Set the properties as shown below.

Select F2

Type 
Motor_Speed_Dec

Creating the 
Motor Speed Screen
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To configure the states of the copied button:

1. Click the States tab on the Push Buttons dialog.

2. In the Text field of state 0, replace /*R*/INC SPD/*R*/F1 with
/*R*/DEC SPD/*R*/F2

3. In the Text field of state 1, replace /*R*/INC with /*R*/DEC

4. Click OK to close the dialog.

Creating the Motor Status Screen Button

The following procedure uses the Copy and Paste functions to copy
the MOTOR SPEED button from the MOTOR STATUS to the
MOTOR SPEED screen.

1. From the Window menu choose Getting Started to activate the
Application File window.

2. Double-click on MOTOR STATUS to open screen 1.

3. Select MOTOR
SPEED

F8

 on the Motor Status screen.

State 0

DEC SPD
F2

State 1

DEC
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4. Click the Copy  tool.

5. Double-click the control-menu box of screen 1 or choose Close
from the Screen menu to close the screen.

Control-menu box

6. Activate screen 2 by clicking the title bar of the screen or
choosing MOTOR SPEED from the Window menu.

7. Click the Paste  tool.

8. Move the outline to the lower right corner of the screen and click
the left mouse button.

To change the inner text of the copied screen button:

1. Click the Inner Text  tool.

2. Replace 
MOTOR
SPEED

F8
 with 

MOTOR
STATUS

F8

ENTER key pressed twice
Don’t worry if this number is different.

3. Click  to exit inner text mode.

To change the properties of the copied screen button:

1. Double-click the object to open its dialog.

2. Set the properties as shown below.

Select Motor Speed

Select F8 for PV900/PV1400 terminals
Select F5 for PV550/PV600 terminals

MOTOR STATUS

3. Click OK to close the dialog.

Creating the 
Motor Speed Screen
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Creating the Speed Bar Graph and Scale

To create a bar graph:

1. Click the Bar Graph tool  in the toolbox.

2. Position the pointer (+), hold down the left mouse button and
drag the pointer to size the bar graph.

3. Click right mouse button or  in toolbox to exit bar graph

mode.

4. From the Format �Fill Pattern menu choose Cross Hatch.

Or click  on the format bar and choose Cross Hatch.

• Select Light Red from the top row of the color palette.
• Select White from the bottom row of the color palette.

Light Red is the Foreground Color

White is the Background Color

For Color



 4–32 Creating the Sample Application

Publication 2711-6.2

To set bar graph properties:

1. Double-click the bar graph object to open its dialog.

2. Set the properties as shown below.

Type 1000

Type
Motor_Speed_Ind

3. Click OK to close the dialog. 

To create the bar graph scale:

1. Click the Scale tool  in the toolbox.

2. Position the pointer (+) at the top, left of the bar graph, hold
down the left mouse button and drag the pointer to size the scale.

3. Click the right mouse button or  to exit scale mode.

Select Light Red from the top row of the color palette.

To specify the number of tick marks:

1. Double-click the scale object to open its dialog.

2. Click in the Number box and type 11.

Type 11

3. Click OK to close the dialog.

Creating the 
Motor Speed Screen
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To create the tick-mark labels (1000, 0):

1. Click the Text tool  in the toolbox.

2. Position pointer (+) to the left of the top tick-mark, click left
mouse button and drag to size the text block.

3. Type 1000 in the Text box.

Don’t worry if this number is different.

4. Click  on the format bar and choose 16x24. Don’t change the

text size for PV550 applications.

5. Choose Right from the Format � Align Text menu or click 

• Select Light Red from the top row of the color palette.
• Select Black from the bottom row of the color palette.

Light Red is the Foreground Color

Black is the Background Color

6. Click  to exit inner text mode.

7. Click the right mouse button or  to exit text mode.

8. Resize the text object if necessary.

9. Click the Copy tool  and then the Paste tool 

Move the outline of the text block to the bottom of the scale.

10. Click  to enter inner text mode.

11. Replace 1000 with 0 in the Text box and then click  to exit

inner text mode.

For Color
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To create the Motor Speed heading above the bar graph:

1. Click  in the toolbox.

2. Position pointer (+) above bar graph and drag to size text block.

3. Type Motor Speed in the Text box.

4. Click  on the format bar and choose 16x24. Don’t change the

text size for PV550 applications.

• Select White from the top row of the color palette.
• Select Black from the bottom row of the color palette.

White is the Foreground Color
Black is the Background Color

5. Click  to exit inner text mode.

6. Click the right mouse button or  to exit text mode.

7. Resize the text object if necessary.

Creating the Speed Numeric Entry Object

Speed Numeric Entry Object

To create the Speed numeric entry object:

1. Click the Cursor Point tool  in the toolbox.

2. Position the pointer (+), hold down the left mouse button and
drag the pointer to size the object.

The object is created with 6 numeric placeholders.

3. Click  to enter inner text mode.

Creating the 
Motor Speed Screen
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4. Click  and choose 16x24. Don’t change the text size for

PV550 applications.

• Select Light Cyan from top row of the color palette.
• Select Magenta from the bottom row of the color palette.

Light Cyan is the Foreground Color Magenta is the Background Color

5. Exit inner text mode.

6. Click the right mouse button or  to exit cursor point mode.

• Select Light Magenta from the top row of the color palette.
• Select Magenta from the bottom row of the color palette.

Light Magenta is the Foreground Color Magenta is the Background Color

To set the properties of the Speed numeric entry object:

1. Double-click the numeric entry object to open its dialog.

2. Set the properties as shown below.

Type
Motor_Speed_Ind

Select 4

Type Motor_Speed

Type Motor_Spd_Notify (for Remote I/O only)

Type Motor_Spd_Handshk (for Remote I/O only)

3. Click OK to close the dialog.

The object now has 4 numeric placeholders ####.

For Color

For Color
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To create the heading ENTER SPEED:

1. Click  in the toolbox.

2. Position pointer (+) above the numeric entry object, hold down
the left mouse button, drag the pointer to size the text block.

3. In the Text box, type ENTER SPEED.

Don’t worry if this number is different.

4. Click  and choose 16x24.

• Select Light Magenta from the top row of the color palette.
• Select Black from the top row of the color palette.

5. Click  to exit inner text mode.

6. Click the right mouse button or  to exit text object mode.

7. Resize the text block, if necessary, to fit all the text.

To create the RPM descriptive label:

1. Click  in the toolbox.

2. Position pointer (+) to the right of the numeric entry object, hold
down the left mouse button, drag pointer to size the text block.

3. In the Text box, type RPM.

Don’t worry if this number is different.

4. Click  and change the text size to 16x24. Don’t change the

text size for PV550 applications.

• Select Light Cyan from the top row of the color palette.
• Select Black from the bottom row of the color palette.

Creating the 
Motor Speed Screen
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5. Click  to exit inner text mode.

6. Click the right mouse button or  to exit text object mode.

7. Resize the text block if necessary.

Creating the RPM Data Display

Numeric
Data
Display

To create the RPM data display:

1. Click the Numeric Data Display tool  in the toolbox.

2. Position the pointer (+), hold down the left mouse button and
drag the pointer to size the object.

The object is created with 6 numeric placeholders.

3. Click  to enter inner text mode.

4. Click  and change the text size to 16x24. Don’t change the

text size for PV550 applications.

• Select Light Red from the top row of the color palette.
• Select Black from the bottom row of the color palette.

5. Click  to exit inner text mode.

6. Click the right mouse button or  to exit data display mode.

For Color
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To set properties of the RPM data display:

1. Double-click the numeric data display object to open its dialog.

2. Set the properties as shown below.

Select Field Width of 4

Type
Motor_Speed_Ind

3. Click OK to close dialog.

The object now has 4 numeric placeholders ####.

To create the numeric data display label  :

1. Select the RPM text block to the right of the numeric entry object.

2. Click the Copy tool 

3. Click the Paste tool 

4. Move outline to the right of the numeric data display and click
the left mouse button.

5. On monochrome terminals, click the Toggle Fore/Background

tool  on the format bar.

• Select Light Red from the top row of the color palette.

Creating the 
Motor Speed Screen
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Closing the Toolbox and Color Palette

To close the toolbox and color palette:

Choose Toolbox and then Color Palette from the View menu.

Or double-click the control-menu box in the upper left of each box.

Closing the Motor Speed Screen

To close the MOTOR SPEED screen:

Choose Close from the Screen menu.

Or double-click the control-menu box on the screen.

Control_menu box

The Application File window now shows 2 screens.

To link the Motor Speed screen to the Motor Status screen:

1. Double-click Motor Status to open the screen.

2. Double-click the Motor Speed screen button to open its dialog.

3. Set the properties as shown below.

Select Motor Speed

Select F8 for PV900/PV1400 terminals
Select F5 for PV600 terminals

4. Click OK to close dialog.

5. Choose Close from Screen menu to close the Motor Status screen.

Linking the Motor Speed
and Motor Status Screens
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This section shows how to create alarms for applications created
with V2.0 or later PanelBuilder Software. 

Procedures show how to create an Alarm Banner, which pops up
over an application screen when an alarm is triggered. The banner
includes:

• Message Display to show an alarm message

• Ack button allowing operator to acknowledge an alarm

• Clear button allowing operator to clear the banner

The Alarm Banner is a global display that is used by all screens in
the application.

To create the Alarm Banner:

1. Choose Create Alarm Banner from the Screen menu.

Alarm Message Display
Message does not appear until
you configure alarm messages.

2. Configure the Clear alarm button.

• Click outside of the Alarm Banner, then select the Clear
button and move it to the left side of banner as shown below.

• Double-click the Clear button to open its dialog. Select the F4
function key and then click OK to close the dialog.

• Click  to enter inner text mode, append F4 (press Enter

after Clear, then type F4) to the text, then exit inner text mode.

Creating Alarms
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3. Create the Ack alarm button.

• Choose Acknowledge from the Objects �Alarm Buttons
submenu.

• Position pointer (+) within the right side of the banner.  Click
the left mouse button to place the Ack button as shown below.

• Click the right mouse button to exit Ack button mode.
• Double-click the Ack button to open its dialog. Select the F7

function key and then click OK to close the dialog.
• Enter inner text mode, append F7 (press Enter after Ack , then

type F7) to the text, then exit inner text mode.

Message does not appear in
display until you configure
alarm messages.

To define the alarm trigger:

1. Double-click the Alarm Message Display in the Alarm Banner.

Or choose Alarm Setup from the Application menu.

The Alarm Setup dialog opens.

2. Click the Alarm Triggers tab.

Type Messages Select Value

3. Click in the Trigger Tag field and type Messages.

4. Click in the Trigger Type field and select Value from the list.
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To define alarm messages:

1. Click the Alarms tab.

A spreadsheet opens.  Each row represents an alarm message.

Use the horizontal scroll bar to
view fields not shown.

1. Edit the following fields for alarm message 1 (row 1):

• In the Text field, type MOTOR SPEED TOO HIGH.
• In the Value/Bit field, type 950.
• In the Trigger field, select Messages.
• In the ACK field, select the check box.

2. Click the right mouse button and choose Append Alarm from the
popup menu.  A new row is added with defaults from row 1.

3. Edit the following fields for alarm message 2 (row 2):

• In the Text field, type MOTOR SPEED TOO LOW.
• In the Value/Bit field, type 50.
• Verify that the ACK field check box is selected.

4. Click on row 1 to display this message in the display.

5. Click OK to exit the Alarm Setup dialog.

To close the Alarm Banner:

Choose Close from the Screen menu.

Or double-click the control-menu box on the screen.

The Application File window now shows the Alarm Banner and 2
screens.
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To save the application file:

1. Choose Save from the File menu.

Or click  on the tool bar.

The Save As dialog box opens. The File Name box shows the first 8
characters of the application name with the .pba file type (default).

If the application was previously saved, the Save As dialog would
not open.  The application would be automatically saved under the
name previously entered in the Save As dialog.

2. Type gtstart.pba in the File Name box.

3. Click the OK button.

The file GTSTART.PBA is saved to the C:\AB\PBWIN folder.
PanelBuilder adds the .PBA extension.

You just finished creating the screens for the getting started
application.

The next chapter will show how to set the power-up and runtime
communication settings for the PanelView terminal.

Saving the Application

�

Summary
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This chapter shows how to define the power-up options and runtime
communication parameters for the PanelView terminal.

When defining communication parameters, refer to either the
DH-485, Remote I/O, or DH+ section depending on the terminal
type you are using.

Section Page

Defining Remote I/O Communication Settings  5–2

Defining DH-485 Communication Settings  5–4

Defining DH+ Communication Settings  5–5

Setting Terminal Power-Up Options  5–6

Saving the Application  5–6

Chapter Objectives
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This section shows how to define runtime communication
parameters for a Remote I/O version of the PanelView terminal.

Skip to page 5–4 if defining runtime communication parameters for
a DH-485 or RS-232 terminal. Skip to page  5–5 if defining runtime
communication parameters for a DH+ terminal.

To configure Remote I/O communications:

1. Choose Terminal Setup from the Application menu.

2. Select the Setup tab.

The dialog shows the name and type of PanelView 900 terminal
defined for the application.  The dialog would look similar for a
PanelView 550 terminal.

The terminal name was defined when the application was created.

3. Click  from the Setup tab.

The Remote I/O Communication Setup dialog opens.

4. Set parameters to match those shown in the dialog below.

Remote I/O Communications dialog
Terminal Name
from Setup tab

Select PLC 5/25

Select 1
Select all check boxes

Select 57600

Defining Remote I/O
Communication Settings

�
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To set up the block transfers for Remote I/O Communications:

1. Click the Block Transfer button.

The Block Transfer dialog opens.

Block Transfer 1 assignment
Block Transfer 2 assignment

Check Pass Through box Select 0

2. Enter data for the 2 block transfers shown above.

For Block Transfer 1:

– Check the Enabled box
– Type N7:0 in the Address field
– Select W (for Write) from the Mode box.
– Select 10 from the Length box.

For Block Transfer 2:

– Check the Enabled box

– Type N7:10 in the Address field

– Select R (for Read) from the Mode box.

– Select 10 from the Length box.

3. Check the Pass Through box.

4. Select 0 from the Block Transfer Timeout box.

5. Click OK to return to the Communication Setup dialog.

6. Click OK to return to the Terminal Setup dialog.

Skip ahead to page  5–6 to set Terminal Power-Up Options.
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This section shows how to define DH-485 runtime communication
parameters for the DH-485 (or RS-232) version of the PanelView
terminal.

To configure DH-485 communications:

1. Choose Terminal Setup from the Application menu.

2. Select the Setup tab.

The dialog shows the name and type of PanelView 900 terminal
defined for the application.  The dialog would look similar for
any PanelView terminal.

The terminal name was defined when the application was created.

3. Click  from the Setup tab.

The DH-485 Communication Setup dialog opens for the terminal.

4. Set parameters to match those shown in the dialog below.

DH-485 Communications Dialog
Terminal Name
from Setup tab

Select 19200

Select 1

Select 2
Select 31

Type SLC_1

5. Click the Apply button.

6. Click OK to return to the Terminal Setup dialog.

7. Click OK to close the Terminal Setup dialog.

Defining DH-485
Communication Settings

�
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This section shows how to define runtime communication
parameters for DH+ version of the PanelView terminal. 

To configure DH+ communications:

1. Choose Terminal Setup from the Application menu.

2. Select the Setup tab.

The dialog shows the name and type of PanelView 900 terminal
defined for the application.  The dialog would look similar for
any PanelView terminal.

The terminal name was defined when the application was created.

3. Click  from the Setup tab.

The DH+ Communication Setup dialog opens for the terminal.

4. Set parameters to match those shown in the dialog below.

DH+ Communications Dialog
Terminal Name
from Setup tab

Select 19200

Select 1

Select 2

Select 57600

Type SLC_1 SLC_1

Note:  SLC_1 is entered to match
the node name in the GS project
(tag database).

5. Click the Apply button.

6. Click OK to return to the Terminal Setup dialog.

7. Click OK to close the Terminal Setup dialog.

DH+ Communication
Settings

�
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To set power-up options for the PanelView Terminal: 

1. Choose Terminal Setup from the Application menu.

2. From the Terminal Setup dialog, select the Power-Up tab.

Select Motor Status

3. Verify that Motor Status is selected from the Startup Screen box.

4. Click the OK button.

To save changes to the application:

Click  on the tool bar.

You just defined power-up settings and runtime communications for
the PanelView terminal.

The next chapter will show you how to enter the application tags.

Setting Terminal
Power-up Options

Saving the Application

Summary
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This chapter contains the following sections.

Sections Page

Opening the Tag Editor  6–1

Overview of Tags  6–2

Entering the Tags  6–3

Exiting Tag Editor  6–5

Using the Form View  6–6

This section shows how to open the Tag Editor to enter, view, or edit
tags for an application.

To open the tag editor:

From the Application menu, choose Tag Editor.

The Tag Editor opens and shows the table view of the editor.

Project Name Maximize button

Status Column

Shows a pencil if you are editing a
row or an X if the row has an error.

Click the Maximize button to enlarge the window.

Chapter Objectives

Opening the Tag Editor

�
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The following tables list tag data for:

• DH-485/DH+ applications communicating with an SLC or PLC
controller.  The tag data is the same for these applications.

For DH+ applications communicating with a PLC, it is okay to
leave SLC_1 in the Node Name field.

• Remote I/O application communicating with a PLC controller

Refer to the appropriate table when entering tags in the next section.

Tags for  DH-485 or  DH+ Getting Started Application (Project GS)

Tag Name Data Type Description
Node Name➀

(Controller)
Tag 

Address
Initial 
Value

Update 
Frequency

Messages Unsigned Integer Displays alarm messages. SLC_1 N7:3 0 1

Motor_AutoManual Unsigned Integer Motor auto/manual indication. SLC_1 N7:0 0 1

Motor_Speed Unsigned Integer Controls motor speed. SLC_1 N7:1 0 1

Motor_Speed_Dec Bit Decrements motor speed. SLC_1 B3:0/3 0 1

Motor_Speed_Inc Bit Increments motor speed. SLC_1 B3:0/2 0 1

Motor_Speed_Ind Unsigned Integer Indicates motor speed. SLC_1 N7:2 0 1

Motor_Start Bit Starts motor. SLC_1 B3:0/0 0 1

Motor_Start_Ind Bit Motor start indication. SLC_1 B3:0/4 0 1

Motor_Stop Bit Stops motor. SLC_1 B3:0/1 0 1

Motor_Stop_Ind Bit Motor stop indication. SLC_1 B3:0/5 0 1

Tags for Remote I/O Getting Started Application (Project GSRIO)

Tag Name Data Type Description
Node Name
(Controller)

Tag 
Address

Initial 
Value

Update 
Frequency

Messages Unsigned Integer Displays alarm messages. PLC_RIO N7:4 0 1

Motor_AutoManual Unsigned Integer Motor auto/manual indication. PLC_RIO N7:10 0 1

Motor_AutoMan_Ind Unsigned Integer Motor auto/manual status
indication.

PLC_RIO N7:3 0 1

Motor_Spd_Handshk Bit Motor speed handshake. PLC_RIO N7:2/2 0 1

Motor_Spd_Notify Bit Motor speed notification. PLC_RIO N7:11/4 0 1

Motor_Speed Unsigned Integer Controls motor speed. PLC_RIO N7:13 0 1

Motor_Speed_Dec Bit Decrements motor speed. PLC_RIO N7:11/0 0 1

Motor_Speed_Inc Bit Increments motor speed. PLC_RIO N7:11/1 0 1

Motor_Speed_Ind Unsigned Integer Indicates motor speed. PLC_RIO N7:1 0 1

Motor_Start Bit Starts motor. PLC_RIO I:010/10 0 1

Motor_Start_Ind Bit Motor start indication. PLC_RIO O:010/10 0 1

Motor_Stop Bit Stops motor. PLC_RIO I:010/11 0 1

Motor_Stop_Ind Bit Motor stop indication. PLC_RIO O:010/11 0 1

Overview of Tags
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Follow the same basic procedure to enter the application tags.

To enter the Messages application tag:

1. Click in the Tag Name field and type Messages.

This icon indicates
the row you are editing.

2. Move to the Data Type field

Move mouse pointer to Data Type field and click the left mouse
button or press the TAB key.

3. Click the arrow on the Data Type box to list the options and click
on Unsigned Integer.

4. Move to Description field and type “Displays alarm messages.”

5. Move to Node Name field and type “PLC_RIO” for the Remote
I/O application, “SLC_1” for the DH-485 or DH+ application.

6. Move to the Address field and type N7:4 for the Remote I/O
application or N7:3 for the DH-485 or DH+ application.

7. Move to the Initial Value field and type 0.

Entering the Tags
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8. Click the arrow on the Update Frequency box to list the options
and click on 1.

9. Save the tag definition by:

Pressing ENTER.

Or moving the cursor to the Tag Name field of the next row.

Or double-clicking in the Status Column box for that tag.

Repeat steps 1 – 10 to create the rest of the tags.  Enter the data
shown in the appropriate table on page  6–2.

Here is what the Tag Editor looks like when you are done entering
the tags.

GSRIO Project – Remote I/O Tags for PLC
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GS Project – DH-485/DH+ Tags for SLC or PLC

To exit the Tag Editor:

From the Project menu choose Exit.

You return to the PanelBuilder workspace.

Exiting the Tag Editor
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The second way to enter tags is to use the form view of the Tag
Editor.  The form view is a dialog which allows you to enter one tag
at a time.  You can access the form view from an object’s dialog
when creating the application or from the Tag Editor.

For details on using the form view, see the PanelBuilder User
Manual (Publication 2711-6.0).

Opens
Form View

Scaling and Data Entry Limit parameters are only 
available from the Form View for specific objects

Double-click object to open 
Numeric Data Display dialog

Using the Form View
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This chapter contains the following sections.

Sections Page

Validating the Application  7–1

Downloading the Application  7–2

Closing the Application  7–4

This section shows how to validate the application for errors.

To validate the sample application:

1. From the Application menu choose Validate All.

The following dialog opens when the application passes
validation.

2. Click OK.

If the application does not pass validation, the Exceptions dialog
opens listing all errors found. You must correct errors and then
re-validate the application.  Warnings do not have to be corrected.

Click to 
close dialog

For details on how to correct the errors and the meaning of the
errors, see the PanelBuilder Software user manual (Publication
2711-6.0).

Chapter Objectives

Validating the Application
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This section shows how to download the sample application from
your computer to a PanelView terminal using a serial link. 

• check cable connections (see Chapter 2).

• use the Internal DF1 driver to download applications to Remote
I/O, DH+ and RS-232 terminals (with an RS-232/DF1 port).

• use the Internal DH485 driver to download applications to
DH-485 terminals.  The DH485 driver requires Windows 95.

To use the internal drivers, INTERCHANGE drivers must be
disabled. Exit windows and type ABICSTOP at the DOS prompt.

To download an application using the Internal DF1 Driver:

Select Operator Terminal

➁  Choose Download from the Application menu.

➀  Open the application you want to download.

➂  Select Download parameters.

Enter name of .PVA file in which to
save the translated .PBA file or click
Browse to search for a file.

Check this box to download the application only if it is
different from the application loaded in the terminal.

Select Internal DF1 Driver

Shows COM port on
which DF1 driver is active

➃  Application is validated and translated to a .PVA file.

➅  Terminal resets, verifies and displays the startup screen of the application.

➄  PanelBuilder software and terminal display status of download.

Click OK to start
download.

The internal DF1 driver is assigned to COM2.

Setup button is
active if more than
one COM port is
available.

gtstart.pva

If errors or warnings are detected, the Exceptions dialog opens.
You must correct errors before download can proceed. 
Warnings should be corrected, but the download will proceed.

GTSTART.PVA

Downloading 
the Application
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To download an application using the Internal DH485 Driver:

➁  Choose Download from the Application menu.

➂  Select the Download parameters.

➃  Application is validated and translated to a .PVA file.

➄  PanelBuilder software and terminal display status of download.

➀  Open the application you want to download.

Enter name of .PVA file in which to
save the translated .PBA file or click
Browse to search for a file.

Check this box to download the application only if it is
different from the application loaded in the terminal.

Select Operator Terminal

Select Internal DH485 Driver

Click OK to start
download.

gtstart.pva

If errors or warnings are detected, the Exceptions dialog
opens. You must correct errors before download can
proceed. Warnings should be corrected, but the
download will proceed.

➅  Terminal resets, verifies and displays the startup screen of the application.

Node address of
terminal on network

Node address of
computer on network

Address of highest
node on network

Baud rate of
DH-485 network

Name of DH-485
network

COM port using Internal
DH485 driver

For DH-485 or RS-232 (DH-485) terminals,
click Setup to verify network parameters.
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You can now close the application (GTSTART.PBA). 

To close an application:

From the File menu choose Close.

Or double-click the control-menu box on the application file
window.

To exit PanelBuilder:

From the File menu choose Exit.

Closing the Application
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This chapter shows how to run the application in the PanelView 900
terminal.  It contains these sections.

Sections Page

Running the Motor in Auto Mode  8–1

Running the Motor in Manual Mode  8–3

This section shows how to monitor the motor in auto mode.  In auto
mode, the motor is controlled by the SLC or PLC and continually
changes speed.  All keys that are pressed in the procedure that
follows are located on the PanelView terminal. 

After the application is downloaded, the PanelView terminal displays
the Motor Status screen.

The Motor Status indicators show that the motor is started and in
Auto mode.

To monitor the status of the motor in auto mode:

1. Press the F2  key to stop the motor.

Or if the terminal has a touch screen, press 

Notice how the Start and Stop motor push buttons change
appearance to show the change in state.

The Status indicator in the Motor Status box also shows the
current status of the motor.

Chapter Objectives

Running the Motor
in Auto Mode
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2. Press the F1  key to restart the motor.

Or if the terminal has a touch screen, press 

3. Press the F8  key to display the Motor Speed screen.

Or if the terminal has a touch screen, press MOTOR
SPEED

In Auto mode, the motor speed is constantly changing and
displayed by the bar graph and numeric data display.

900
900

You cannot enter a new speed or increase/decrease the motor
speed while in auto mode.

4. Press the F8  key to return to the Motor Status screen.

Or if the terminal has a touch screen, press MOTOR
STATUS

Alarm messages are not triggered while in auto mode.�
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This section shows how to control and monitor the motor in manual
mode.  All keys that are pressed in the procedure that follows are
located on the PanelView terminal.

To control and monitor the status of the motor in manual mode:

1. Press  and then  to select Manual from the Select Mode
control list.

Or if the terminal has a touch screen, press the equivalent list
keys to right of the control list.

The Mode indicator shows that the motor is in Manual mode.

2. Press the F8  key to return to the Motor Speed screen.

Or if the terminal has a touch screen, press MOTOR
SPEED

The screen shows the current speed of the motor.

100
100

In manual mode, you can enter a new motor speed, increase or
decrease the motor speed.  The bar graph and numeric data
display are automatically updated to reflect the change in speed.

3. Press  to open the scratchpad.

Or if the terminal has a touch screen, press the Enter Speed object
to open the touch screen scratchpad.

Running the Motor
in Manual Mode
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4. Enter a value of 500 in the scratchpad and press 

Objects are automatically updated to reflect the new speed.

500
500

5. Press F1  key to increase the motor speed.

Or if the terminal has a touch screen, press MENU
F5

Objects are updated to reflect the new speed.

6. Press F1  key twice to increase the speed again.

Or hold down F1  until the speed increases by 20 RPM.

7. Hold down the F2  key until the speed decreases 30 RPM.

Or if the terminal has a touch screen, press MENU
F5

Objects are automatically updated to reflect the new speed.

The following alarm messages are triggered in manual mode.

• MOTOR SPEED TOO HIGH when motor speed is greater than
950 RPM.

• MOTOR SPEED TOO LOW when motor speed is less than 50
RPM

�
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PanelView Getting Started Application for SLC DH485/DH+            
Program Listing           Processor File: GETSTRTD.ACH

Rung 2:0
Timer for incrementing and decrementing motor speed in auto mode.
| T4:0                                               +TON–––––––––––––––+      |
|––]/[–––––––––––––––––––––––––––––––––––––––––––––––+TIMER ON DELAY    +–(EN)–|
|    DN                                              |Timer         T4:0+–(DN) |
|                                                    |Time Base     0.01|      |
|                                                    |Preset         200|      |
|                                                    |Accum            0|      |
|                                                    +––––––––––––––––––+      |

Rung 2:1
The motor is started when the Start Push Button is pressed on the PanelView.
Start status is indicated by B3:0/4.
|    B3                                                                   B3   |
|–+––] [––––––––+–––––––––––––––––––––––––––––––––––––––––––––––––––––––––( )––|
| |     0       |                                                            4 |
| |  B3    B3   |                                                              |
| +––] [–––]/[––+                                                              |
|       4     5                                                                |

Rung 2:2
The motor is stopped when the Stop Push Button is pressed on the PanelView.  
Stop status is indicated by B3:0/5.
|    B3                                                                   B3   |
|–+––] [––––––––+–––––––––––––––––––––––––––––––––––––––––––––––––––––––––( )––|
| |     1       |                                                            5 |
| |  B3    B3   |                                                              |
| +––] [–––]/[––+                                                              |
|       5     4                                                                |

Rung 2:3
The latch bit (B3:0/6) is set when counter C5:0 is done incrementing.  This
causes the  motor speed to begin decrementing if auto mode is selected.
| C5:0                                                                    B3   |
|––] [––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––(L)––|
|    DN                                                                      6 |

Rung 2:4
The latch bit (B3:0/6) is unlatched when counter C5:0 is done decrementing.
This causes the motor speed to begin incrementing if auto mode is selected.
| +EQU–––––––––––––––+                                                    B3   |
|–+EQUAL             +––––––––––––––––––––––––––––––––––––––––––––––––––––(U)––|
| |Source A  C5:0.ACC|                                                       6 |
| |                 0|                                                         |
| |Source B         0|                                                         |
| |                  |                                                         |
| +––––––––––––––––––+                                                         |
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Rung 2:5
Counter C5:0 indicates the speed of the motor.  If auto mode is selected and
the motor is started the counter will increment.
| T4:0  +EQU–––––––––––––––+  B3   C5:0   B3         +CTU–––––––––––––––+      |
|––] [––+EQUAL             +––] [–––]/[–––]/[––––––––+COUNT UP          +–(CU)–|
|    DN |Source A      N7:0|     4    DN     6       |Counter       C5:0+–(DN) |
|       |                 0|                         |Preset          20|      |
|       |Source B         0|                         |Accum            0|      |
|       |                  |                         +––––––––––––––––––+      |
|       +––––––––––––––––––+                                                   |

Rung 2:6
Counter C5:0 indicates the speed of the motor.  If auto mode is selected and
the motor is started the counter will decrement.
| T4:0  +EQU–––––––––––––––+  B3    B3               +CTD–––––––––––––––+      |
|––] [––+EQUAL             +––] [–––] [––––––––––––––+COUNT DOWN        +–(CD)–|
|    DN |Source A      N7:0|     4     6             |Counter       C5:0+–(DN) |
|       |                 0|                         |Preset          20|      |
|       |Source B         0|                         |Accum            0|      |
|       |                  |                         +––––––––––––––––––+      |
|       +––––––––––––––––––+                                                   |

Rung 2:7
The motor speed is scaled by a value of 50 and stored in address N7:1 when in
auto mode.
| +EQU–––––––––––––––+                                    +MUL–––––––––––––––+ |
|–+EQUAL             +––––––––––––––––––––––––––––––––––––+MULTIPLY          +–|
| |Source A      N7:0|                                    |Source A  C5:0.ACC| |
| |                 0|                                    |                 0| |
| |Source B         0|                                    |Source B        50| |
| |                  |                                    |                  | |
| +––––––––––––––––––+                                    |Dest          N7:1| |
|                                                         |                 0| |
|                                                         +––––––––––––––––––+ |

Rung 2:8
The operator entered motor speed, indicated by N7:1, is scaled and stored in
C5:0 when manual mode is selected.
| +EQU–––––––––––––––+                                    +DIV–––––––––––––––+ |
|–+EQUAL             +––––––––––––––––––––––––––––––––––––+DIVIDE            +–|
| |Source A      N7:0|                                    |Source A      N7:1| |
| |                 0|                                    |                 0| |
| |Source B         1|                                    |Source B        50| |
| |                  |                                    |                  | |
| +––––––––––––––––––+                                    |Dest      C5:0.ACC| |
|                                                         |                 0| |
|                                                         +––––––––––––––––––+ |

Rung 2:9
Timer used for incrementing and decrementing motor speed when manual mode is
selected.
| T4:1                                               +TON–––––––––––––––+      |
|––]/[–––––––––––––––––––––––––––––––––––––––––––––––+TIMER ON DELAY    +–(EN)–|
|    DN                                              |Timer         T4:1+–(DN) |
|                                                    |Time Base     0.01|      |
|                                                    |Preset          50|      |
|                                                    |Accum            0|      |
|                                                    +––––––––––––––––––+      |
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Rung 2:10
When the motor is started or stopped, the motor speed is moved to N7:2.  The 
PanelView displays the value at N7:2.
|  B3                                                            +MOV–––––––––––––––+ |
|––] [––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––+MOVE             +–|
|     4                                                          |Source        N7:1| |
|                                                                |                 0| |
|                                                                |Dest          N7:2| |
|                                                                |                 0| |
|                                                                +––––––––––––––––––+ |

Rung 2:11
When the motor is started or stopped, the motor speed is moved to N7:2.  The PanelView
displays the value at N7:2.
|  B3                                                            +MOV–––––––––––––––+ |
|––] [–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––+MOVE              +–|
|     5                                                          |Source           0| |
|                                                                |                  | |
|                                                                |Dest          N7:2| |
|                                                                |                 0| |
|                                                                +––––––––––––––––––+ |

Rung 2:12
The motor speed is incremented by a value of 10 if the increment push button
is pressed, manual mode is selected, and the motor is started.
|  B3   T4:1  +EQU–––––––––––––––+  B3   +LEQ–––––––––––––––+    +ADD–––––––––––––––+ |   
|––] [–––] [––+EQUAL             +––] [––+LESS THAN OR EQUAL+––––+ADD               +–|
|     2    DN |Source A      N7:0|     4 |Source A      N7:1|    |Source A      N7:1| |
|             |                 0|       |                 0|    |                 0| |
|             |Source B         1|       |Source B       990|    |Source B        10| |
|             |                  |       |                  |    |                  | |
|             +––––––––––––––––––+       +––––––––––––––––––+    |Dest          N7:1| |
|                                                                |                 0| |
|                                                                +––––––––––––––––––+ |

Rung 2:13
The motor speed is decremented by a value of 10 if the decrement push button
is pressed, manual mode is selected, and the motor is started.
|  B3   T4:1  +EQU–––––––––––––––+  B3   +GEQ–––––––––––––––+    +SUB–––––––––––––––+ |   
|––] [–––] [––+EQUAL             +––] [––+GRTR THAN OR EQUAL+––––+SUBTRACT          +–|
|     3    DN |Source A      N7:0|     4 |Source A      N7:1|    |Source A      N7:1| |   
|             |                 0|       |                 0|    |                 0| |
|             |Source B         1|       |Source B        10|    |Source B        10| |
|             |                  |       |                  |    |                  | | 
|             +––––––––––––––––––+       +––––––––––––––––––+    |Dest          N7:1| | 
|                                                                |                 0| |
|                                                                +––––––––––––––––––+ |

Rung 2:14
| +LIM–––––––––––––––+                                           +MOV–––––––––––––––+ |
|–+LIMIT TEST        +–––––––––––––––––––––––––––––––––––––––––––+MOVE              +–|
| |Low Lim        950|                                           |Source         950| |
| |                  |                                           |                  | |
| |Test          N7:1|                                           |Dest          N7:3| |
| |                 0|                                           |                 0| |
| |High Lim      1000|                                           +––––––––––––––––––+ |
| |                  |                                                                |
| +––––––––––––––––––+                                                                |
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Rung 2:15
| +LIM–––––––––––––––+                                    +MOV–––––––––––––––+ |
|–+LIMIT TEST        +––––––––––––––––––––––––––––––––––––+MOVE              +–|
| |Low Lim          0|                                    |Source          50| |
| |                  |                                    |                  | |
| |Test          N7:1|                                    |Dest          N7:3| |
| |                 0|                                    |                 0| |
| |High Lim        50|                                    +––––––––––––––––––+ |
| |                  |                                                         |
| +––––––––––––––––––+                                                         |

Rung 2:16
| +LIM–––––––––––––––+                                    +MOV–––––––––––––––+ |
|–+LIMIT TEST        +––––––––––––––––––––––––––––––––––––+MOVE              +–|
| |Low Lim         51|                                    |Source           0| |
| |                  |                                    |                  | |
| |Test          N7:1|                                    |Dest          N7:3| |
| |                 0|                                    |                 0| |
| |High Lim       949|                                    +––––––––––––––––––+ |
| |                  |                                                         |
| +––––––––––––––––––+                                                         |

Rung 2:17
|                                                                              |
|–––––––––––––––––––––––––––––––––––––+END+––––––––––––––––––––––––––––––––––––|
|                                                                              |
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Program Listing Report for RIO              PLC–5/25    File GSRIO1

Rung 2:0
Block transfer data for PanelView outputs.
| N17:0 N17:20                                  +BTW––––––––––––––––––––+      |
+––]/[–––]/[––––––––––––––––––––––––––––––––––––+BLOCK TRANSFER WRITE   +–(EN)–+
|    15    15                                   |Rack                 01|      |
|                                               |Group                 0+–(DN) |
|                                               |Module                0|      |
|                                               |Control block     N17:0+–(ER) |
|                                               |Data file          N7:0|      |
|                                               |Length               10|      |
|                                               |Continuous            N|      |
|                                               +–––––––––––––––––––––––+      |

Rung 2:1
Block transfer data for PV inputs.
| N17:20 N17:0                                  +BTR––––––––––––––––––––+      |
+––]/[––––]/[–––––––––––––––––––––––––––––––––––+BLOCK TRANSFER READ    +–(EN)–+
|    15     15                                  |Rack                 01|      |
|                                               |Group                 0+–(DN) |
|                                               |Module                0|      |
|                                               |Control block    N17:20+–(ER) |
|                                               |Data file         N7:10|      |
|                                               |Length               10|      |
|                                               |Continuous            N|      |
|                                               +–––––––––––––––––––––––+      |

Rung 2:2
When the start motor push button is pressed, set the motor start indicator and
reset the motor stop indicator.
| Start                                                            Motor       |
| motor                                                            started     |
| pushbutton                                                       indicator   |
|   I:010                                                            O:010     |
+––––] [––––––––––––––––––––––––––––––––––––––––––––––––––––––––––+–––(L)––––+–+
|      10                                                         |     10   | |
|                                                                 |Motor     | |
|                                                                 |stopped   | |
|                                                                 |indicator | |
|                                                                 |  O:010   | |
|                                                                 +–––(U)––––+ |
|                                                                       11     |

Rung 2:3
When the stop motor push button is pressed, set the motor stop indicator and
reset the motor start indicator.
| Stop                                                             Motor       |
| motor                                                            stopped     |
| pushbutton                                                       indicator   |
|   I:010                                                            O:010     |
+––––] [––––––––––––––––––––––––––––––––––––––––––––––––––––––––––+–––(L)––––+–+
|      11                                                         |     11   | |
|                                                                 |Motor     | |
|                                                                 |started   | |
|                                                                 |indicator | |
|                                                                 |  O:010   | |
|                                                                 +–––(U)––––+ |
|                                                                       10     |
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Rung 2:4
In auto mode, N7:10 equals 0.
In manual mode, N7:10 equals 1.
|      Auto/Man                                                Auto/Man        |
|      indicator                                               status          |
|                                                              indicator       |
| +EQU–––––––––––––––+                                    +MOV–––––––––––––––+ |
+–+EQUAL             +––––––––––––––––––––––––––––––––––––+MOVE              +–+
| |Source A     N7:10|                                    |Source           0| |
| |                 1|                                    |                  | |
| |Source B         0|                                    |Destination   N7:3| |
| |                  |                                    |                 1| |
| +––––––––––––––––––+                                    +––––––––––––––––––+ |

Rung 2:5
In auto mode, N7:10 equals 0.
In manual mode, N7:10 equals 1.
|      Auto/Man                                                Auto/Man        |
|      indicator                                               status          |
|                                                              indicator       |
| +EQU–––––––––––––––+                                    +MOV–––––––––––––––+ |
+–+EQUAL             +––––––––––––––––––––––––––––––––––––+MOVE              +–+
| |Source A     N7:10|                                    |Source           1| |
| |                 1|                                    |                  | |
| |Source B         1|                                    |Destination   N7:3| |
| |                  |                                    |                 1| |
| +––––––––––––––––––+                                    +––––––––––––––––––+ |

Rung 2:6
Timer for incrementing and decrementing the motor speed in auto mode.
|  T4:0                                              +TON–––––––––––––––+      |
+––]/[–––––––––––––––––––––––––––––––––––––––––––––––+TIMER ON DELAY    +–(EN)–+
|    DN                                              |Timer         T4:0|      |
|                                                    |Time base     0.01+–(DN) |
|                                                    |Preset          50|      |
|                                                    |Accum           36|      |
|                                                    +––––––––––––––––––+      |

Rung 2:7
The latched bit (B3:0/3) is used to decrement the motor speed in auto mode.
|  C5:0                                                                    B3  |
+––] [––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––(L)––+
|    DN                                                                      3 |

Rung 2:8
The unlatch bit (B3:0/3) is used to increment the motor speed in auto mode.
| +EQU–––––––––––––––+                                                     B3  |
+–+EQUAL             +––––––––––––––––––––––––––––––––––––––––––––––––––––(U)––+
| |Source A  C5:0.ACC|                                                       3 |
| |                 6|                                                         |
| |Source B         0|                                                         |
| |                  |                                                         |
| +––––––––––––––––––+                                                         |
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Rung 2:9
In auto mode, the motor speed will continually increment and decrement between
zero and one thousand.
|            Auto/Man        Motor                                             |
|            indicator       started                                           |
|                            indicator                                         |
|  T4:0 +EQU–––––––––––––––+   O:010            B3  +CTU–––––––––––––––+       |
+––] [––+EQUAL             +––––] [––––––––––+–]/[––+COUNT UP          +–(CU)+–+
|    DN |Source A     N7:10|      10         |    3 |Counter       C5:0|     | |
|       |                 1|                 |      |Preset          20+–(DN)| |
|       |Source B         0|                 |      |Accum            6|     | |
|       |                  |                 |      +––––––––––––––––––+     | |
|       +––––––––––––––––––+                 |  B3  +CTD–––––––––––––––+     | |
|                                            +–] [––+COUNT DOWN        +–(CD)+ |
|                                            |    3 |Counter       C5:0|     | |
|                                            |      |Preset          20+–(DN)| |
|                                            |      |Accum            6|     | |
|                                            |      +––––––––––––––––––+     | |
|                                            |                Motor          | |
|                                            |                speed          | |
|                                            |                indicator      | |
|                                            |           +MUL–––––––––––––––+| |
|                                            +–––––––––––+MULTIPLY          ++ |
|                                                        |Source A  C5:0.ACC|  |
|                                                        |                 6|  |
|                                                        |Source B        50|  |
|                                                        |                  |  |
|                                                        |Destination   N7:1|  |
|                                                        |               510|  |
|                                                        +––––––––––––––––––+  |

Rung 2:10
In manual mode, the motor speed is incremented by ten each time the increment
motor speed push button goes from a false to true transition.
|      Auto/Man        Increment                               Motor           |
|      status          motor                                   speed           |
|      indicator       speed                                   indicator       |
|                      pushbutton                                              |
| +EQU–––––––––––––––+   N7:11     T4:0                   +ADD–––––––––––––––+ |
+–+EQUAL             +––––] [––––––] [––––––––––––––––––––+ADD               +–+
| |Source A      N7:3|       1       DN                   |Source A        10| |
| |                 1|                                    |                  | |
| |Source B         1|                                    |Source B      N7:1| |
| |                  |                                    |               510| |
| +––––––––––––––––––+                                    |Destination   N7:1| |
|                                                         |               510| |
|                                                         +––––––––––––––––––+ |

Rung 2:11
In manual mode, the motor speed is decremented by one each time the decrement
motor speed push button goes from a false to true transition.
|      Auto/Man        Decrement                               Motor           |
|      status          motor                                   speed           |
|      indicator       speed                                   indicator       |
|                      pushbutton                                              |
| +EQU–––––––––––––––+   N7:11     T4:0                   +SUB–––––––––––––––+ |
+–+EQUAL             +––––] [––––––] [––––––––––––––––––––+SUBTRACT          +–+
| |Source A      N7:3|       0       DN                   |Source A      N7:1| |
| |                 1|                                    |               510| |
| |Source B         1|                                    |Source B        10| |
| |                  |                                    |                  | |
| +––––––––––––––––––+                                    |Destination   N7:1| |
|                                                         |               510| |
|                                                         +––––––––––––––––––+ |
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Rung 2:12
When the motor speed notification bit is set, set the motor speed handshake bit
and set the indicated motor speed to reflect the entered motor speed.
| Motor                                                            Motor       |
| speed                                                            speed       |
| notifica–                                                        handshake   |
| tion                                                                         |
|   N7:11                                                             N7:2     |
+––––] [––––––––––––––––––––––––––––––––––––––––––––––––+–––––––––––––( )––––+–+
|       4                                               |                2   | |
|                                                       |     Motor          | |
|                                                       |     speed          | |
|                                                       |     indicator      | |
|                                                       |+MOV–––––––––––––––+| |
|                                                       ++MOVE              ++ |
|                                                        |Source       N7:13|  |
|                                                        |               999|  |
|                                                        |Destination   N7:1|  |
|                                                        |               510|  |
                                                         +––––––––––––––––––+  |

Rung 2:13
|      Maximum                                                 Motor           |
|      motor                                                   speed           |
|      speed is 1000                                           indicator       |
|                                                                              |
| +GRT–––––––––––––––+                                    +MOV–––––––––––––––+ |
+–+GREATER THAN      +––––––––––––––––––––––––––––––––––––+MOVE              +–+
| |Source A      N7:1|                                    |Source        1000| |
| |               510|                                    |                  | |
| |Source B      1000|                                    |Destination   N7:1| |
| |                  |                                    |               510| |
| +––––––––––––––––––+                                    +––––––––––––––––––+ |

Rung 2:14
|      Minimum                                                 Motor           |
|      motor                                                   speed           |
|      speed is zero                                           indicator       |
|                                                                              |
| +LES–––––––––––––––+                                    +MOV–––––––––––––––+ |
+–+LESS THAN         +––––––––––––––––––––––––––––––––––––+MOVE              +–+
| |Source A      N7:1|                                    |Source           0| |
| |               510|                                    |                  | |
| |Source B         0|                                    |Destination   N7:1| |
| |                  |                                    |               510| |
| +––––––––––––––––––+                                    +––––––––––––––––––+ |

Rung 2:15
| Motor stop                                                   Motor           |
| indicator                                                    speed           |
|                                                              indicator       |
|   O:010                                                 +MOV–––––––––––––––+ |
+––––] [––––––––––––––––––––––––––––––––––––––––––––––––––+MOVE              +–+
|      11                                                 |Source           0| |
|                                                         |                  | |
|                                                         |Destination   N7:1| |
|                                                         |               510| |

             +––––––––––––––––––+ |
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Rung 2:16
|      Motor                Auto/Man                                           |
|      speed                indicator                                          |
|      indicator                                                               |
| +EQU–––––––––––––––+ +EQU–––––––––––––––+               +MOV–––––––––––––––+ |
+–+EQUAL             +–+EQUAL             +–––––––––––––––+MOVE              +–+
| |Source A      N7:1| |Source A     N7:10|               |Source         950| |
| |               510| |                 1|               |                  | |
| |Source B       950| |Source B         1|               |Destination   N7:4| |
| |                  | |                  |               |                 0| |
| +––––––––––––––––––+ +––––––––––––––––––+               +––––––––––––––––––+ |

Rung 2:17
|      Motor                Auto/Man                                           |
|      speed                indicator                                          |
|      indicator                                                               |
| +EQU–––––––––––––––+ +EQU–––––––––––––––+               +MOV–––––––––––––––+ |
+–+EQUAL             +–+EQUAL             +–––––––––––––––+MOVE              +–+
| |Source A      N7:1| |Source A     N7:10|               |Source          50| |
| |               510| |                 1|               |                  | |
| |Source B        50| |Source B         1|               |Destination   N7:4| |
| |                  | |                  |               |                 0| |
| +––––––––––––––––––+ +––––––––––––––––––+               +––––––––––––––––––+ |

Rung 2:18
|                                                                              |
+––––––––––––––––––––––––––––––––[END OF FILE]–––––––––––––––––––––––––––––––––+
|                                                                              |



 
�������	 �

Publication 2711-6.2

��� �	���� ����
 �����	� 
��

��� �����
	����

Program Listing           Processor File: GSDHP.AF5

Rung 2:0
Timer for incrementing and decrementing motor speed in auto mode.
|     T4:0                                           +TON–––––––––––––––+      |
|––––]/[–––––––––––––––––––––––––––––––––––––––––––––+TIMER ON DELAY    +–(EN)–|
|      DN                                            |Timer         T4:0+–(DN) |
|   (2:0)                                            |Time Base     0.01|      |
|                                                    |Preset         200|      |
|                                                    |Accum            0|      |
|                                                    +––––––––––––––––––+      |
 

Rung 2:1
The motor is started when the Start Push Button is pressed on the PanelView.
Start status is indicated by B3:0/4.
|    B3                                                                   B3   |
|–+––] [––––––––––––––––––+–––––––––––––––––––––––––––––––––––––––––––––––( )––|
| |     0                 |                                                  4 |
| |      B3         B3    |                                                    |
| +––––] [––––––––]/[–––––+                                                    |
|         4          5                                                         |
                                                      |

Rung 2:2
The motor is stopped when the Stop Push Button is pressed on the PanelView.
Stop status is indicated by B3:0/5.
|    B3                                                                   B3   |
|–+––] [––––––––––––––––––+–––––––––––––––––––––––––––––––––––––––––––––––( )––|
| |     1                 |                                                  5 |
| |      B3         B3    |                                                    |
| +––––] [––––––––]/[–––––+                                                    |
|         5          4                                                         |
                                                      |

Rung 2:3
The latch bit (B3:0/6) is unlatched when counter C5:0 is done decrementing.
This causes the motor speed to begin incrementing if auto mode is selected.
|     C5:0                                                                B3   |
|––––] [––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––(L)––|
|      DN                                                                    6 |
 

Rung 2:4
The latch bit (B3:0/6) is unlatched when counter C5:0 is done decrementing.
This causes the motor speed to begin incrementing if auto mode is selected.
| +EQU–––––––––––––––+                                                    B3   |
|–+EQUAL             +––––––––––––––––––––––––––––––––––––––––––––––––––––(U)––|
| |Source A  C5:0.ACC|                                                       6 |
| |                 0|                                                         |
| |Source B         0|                                                         |
| |                  |                                                         |
| +––––––––––––––––––+
 

Rung 2:5
Counter C5:0 indicates the speed of the motor.  If auto mode is selected and
the motor is started the counter will increment.
| T4:0  +EQU–––––––––––––––+    B3    C5:0  B3       +CTU–––––––––––––––+      |     
|––] [––+EQUAL             +––] [–––]/[–––]/[––––––––+COUNT UP          +–(CU)–|
|    DN |Source A      N7:0|     4    DN     6       |Counter       C5:0+–(DN) |     
|       |                 0|          |Preset          20|      |
|       |Source B         0|         |Accum            0|      |
|       |                  |         +––––––––––––––––––+      |
|       +––––––––––––––––––+
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Rung 2:6
Counter C5:0 indicates the speed of the motor.  If auto mode is selected and
the motor is started the counter will decrement.
| T4:0  +EQU–––––––––––––––+    B3    B3             +CTD–––––––––––––––+      |     
|––] [––+EQUAL             +––] [–––] [––––––––––––––+COUNT DOWN        +–(CD)–|
|    DN |Source A      N7:0|     4     6             |Counter       C5:0+–(DN) |     
|       |                 0|           |Preset          20|      |
|       |Source B         0|                    |Accum            0|      |
|       |                  |         +––––––––––––––––––+      |
|       +––––––––––––––––––+

Rung 2:7
The motor speed is scaled by a value of 50 and stored in address N7:1 when in 
auto mode.
| +EQU–––––––––––––––+                                    +MUL–––––––––––––––+ |
|–+EQUAL             +––––––––––––––––––––––––––––––––––––+MULTIPLY          +–|
| |Source A      N7:0|                                    |Source A  C5:0.ACC| |
| |                 0|                                    |                 0| |
| |Source B         0|                                    |Source B        50| |
| |                  |                                    |                  | |
| +––––––––––––––––––+                                    |Dest          N7:1| |
|                                                         |                 0| |
|                                                         +––––––––––––––––––+ |

Rung 2:8
The operator entered motor speed, indicated by N7:1, is scaled and stored in 
C5:0 when manual mode is selected.
| +EQU–––––––––––––––+                                    +DIV–––––––––––––––+ |
|–+EQUAL             +––––––––––––––––––––––––––––––––––––+DIVIDE            +–|
| |Source A      N7:0|                                    |Source A      N7:1| |
| |                 0|                                    |                 0| |
| |Source B         1|                                    |Source B        50| |
| |                  |                                    |                  | |
| +––––––––––––––––––+                                    |Dest      C5:0.ACC| |
|                                                         |                 0| |
|                                                         +––––––––––––––––––+ |

Rung 2:9
Timer used for incrementing and decrementing motor speed when manual mode is 
selected.
|     T4:1                                           +TON–––––––––––––––+      |
|––––]/[–––––––––––––––––––––––––––––––––––––––––––––+TIMER ON DELAY    +–(EN)–|
|      DN                                            |Timer         T4:1+–(DN) |
|                                                    |Time Base     0.01|      |
|                                                    |Preset          50|      |
|                                                    |Accum            0|      |
|                                                    +––––––––––––––––––+      |
 

Rung 2:10
When the motor is started or stopped, the motor speed is moved to N7:2.  The 
PanelView displays the value at N7:2.
|      B3                                                 +MOV–––––––––––––––+ |
|––––] [––––––––––––––––––––––––––––––––––––––––––––––––––+MOVE              +–|
|       4                                                 |Source        N7:1| |
|                                                         |                 0| |
|                                                         |Dest          N7:2| |
|                                                         |                 0| |
|                                                         +––––––––––––––––––+ |
 

Rung 2:11
When the motor is started or stopped, the motor speed is moved to N7:2.  The
PanelView displays the value at N7:2.
|      B3                                                 +MOV–––––––––––––––+ |
|––––] [––––––––––––––––––––––––––––––––––––––––––––––––––+MOVE              +–|
|       5                                                 |Source           0| |
|                                                         |                  | |
|                                                         |Dest          N7:2| |
|                                                         |                 0| |
|                                                         +––––––––––––––––––+ |
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Rung 2:12
The motor speed is incremented by a value of 10 if the increment push button
is pressed, manual mode is selected, and the motor is started.
|  B3    T4:1  +EQU––––––––––––+   B3  +LEQ–––––––––––––––+ +ADD–––––––––––––+ | 
|––] [–––] [–––+EQUAL          +––] [––+LESS THAN OR EQUAL+–+ADD             +–|
|     2    DN  |Source A   N7:0|    4  |Source A      N7:1| |Source A    N7:1| |  
|              |              0|       |                 0| |               0| |
|              |Source B      1|       |Source B       990| |Source B      10| |
|              |               |       |                  | |                | |     
|              +–––––––––––––––+       +––––––––––––––––––+ |Dest        N7:1| |
                                                            |               0| |

    +––––––––––––––––+ |

Rung 2:13
The motor speed is decremented by a value of 10 if the decrement push button
is pressed, manual mode is selected, and the motor is started.
|  B3   T4:1 +EQU–––––––––––+  B3   +GEQ–––––––––––––––+  +SUB–––––––––––––––+ |  
|––] [––] [––+EQUAL         +––] [––+GRTR THAN OR EQUAL+––+SUBTRACT          +–|
|    3    DN |Source A  N7:0|    4  |Source A      N7:1|  |Source A      N7:1| |     
|            |             0|       |                 0|  |                 0| |
|            |Source B     1|       |Source B        10|  |Source B        10| |
|            |              |       |                  |  |                  | |
|            +––––––––––––––+       +––––––––––––––––––+  |Dest          N7:1| |
|                                               |                 0| |

  +––––––––––––––––––+ |
 

Rung 2:14
| +LIM–––––––––––––––+                                    +MOV–––––––––––––––+ |
|–+LIMIT TEST        +––––––––––––––––––––––––––––––––––––+MOVE              +–|
| |Low Lim        950|                                    |Source         950| |
| |                  |                                    |                  | |
| |Test          N7:1|                                    |Dest          N7:3| |
| |                 0|                                    |                 0| |
| |High Lim      1000|                                    +––––––––––––––––––+ |
| |                  |                                                         |
| +––––––––––––––––––+                                                         |

Rung 2:15
| +LIM–––––––––––––––+                                    +MOV–––––––––––––––+ |
|–+LIMIT TEST        +––––––––––––––––––––––––––––––––––––+MOVE              +–|
| |Low Lim          0|                                    |Source          50| |
| |                  |                                    |                  | |
| |Test          N7:1|                                    |Dest          N7:3| |
| |                 0|                                    |                 0| |
| |High Lim        50|                                    +––––––––––––––––––+ |
| |                  |                                                         |
| +––––––––––––––––––+                                                         |
                                                             |

Rung 2:16
| +LIM–––––––––––––––+                                    +MOV–––––––––––––––+ |
|–+LIMIT TEST        +––––––––––––––––––––––––––––––––––––+MOVE              +–|
| |Low Lim         51|                                    |Source           0| |
| |                  |                                    |                  | |
| |Test          N7:1|                                    |Dest          N7:3| |
| |                 0|                                    |                 0| |
| |High Lim       949|                                    +––––––––––––––––––+ |
| |                  |                                                         |
| +––––––––––––––––––+                                                         |

Rung 2:17
|                                                                              |
|–––––––––––––––––––––––––––––––––––––+END+––––––––––––––––––––––––––––––––––––|
|                                                                              |
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